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The growing contamination of surface water by stormwater runoff parallels increasing urban
development. Heavy metals, polycyclic aromatic hydrocarbons (PAHs), persistent organic
pollutants (POPs), and contaminants of emerging concern (CECs) are discharged from point
sources and washed from impervious surfaces into surface waters, impacting the ecology of
these systems, food supplies, and the source waters for drinking water. Green stormwater
infrastructure reduces peak runoff and removes contaminants, while providing the structure to
support microbial communities and stabilize the soil. Vegetation health plays a large role in
the effectiveness of green infrastructure installations, with unhealthy vegetation reducing
uptake and transpiration rates, as well as filtration effectiveness. Monitoring the health of
vegetation in stormwater green infrastructure can indicate signs of water stress, disease, as
well as pollutant induced toxicity. Early detection of stress in vegetation can inform
management and maintenance decisions. This study examines one remote and one groundbased method for monitoring biomass and primary production in two cells of a bioretention
facility, one cell (Cell 2) containing sedges, rushes and grasses and the other (Cell 3)
containing a mix of sedges, rushes, grasses and broadleaf vegetation. Ground-based
measurements of the fraction of intercepted photosynthetically active radiation (fIPAR)
produced unreliable results with challenges leading to over and under-estimates of intercepted
PAR. fIPAR and the normalized difference vegetation index (NDVI) were poorly correlated
for both bioretention cells, with coefficients of determination for Cell 2 (0.13) being lower
than Cell 3 (0.49). However, radiometric calibration of UAS data from inexpensive sensors

using the empirical line method (ELM) and three inexpensive ethylene-vinyl acetate (EVA)
foam panels produced reasonable results. Linear regression equations were derived for the red
and NIR bands of imagery with coefficients of determination from the three image sets
ranging from 0.636 to 0.999. To increase the accuracy of the method, additional calibration
targets should be used. The resulting NDVI data was tracked over a two-month period during
the transition from spring to summer. The NDVI data was useful in exploring the spatial
distribution of NDVI and how NDVI value coverage areas change over time.
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Introduction
As urban areas expand, so does the contamination of surface water by stormwater
runoff. This creates an increased load on municipalities and industries to counter the challenges
created by these waste streams and to preserve our water resources. The transformation of rural
areas to urban will continue, with 51% of land classified as rural in 2003 expected to be
developed by 2030 (White et al., 2009). Increased development creates new impervious
surfaces, which causes an increase in surface runoff volume and contaminant loads carried to
receiving waters. According to the USEPA, urban runoff and pollution concentrations are
directly related to the impervious area in a watershed (1999).
Heavy metals, polycyclic aromatic hydrocarbons (PAHs), persistent organic pollutants
(POPs), and contaminants of emerging concern (CECs) are washed into surface waters. With
70% of the population receiving drinking water from surface water sources, the quality of
source water and the ability of drinking water treatment plants to remove these contaminants
is critical (USEPA, 2009a). Removal of these contaminants in wastewater and drinking water
treatment facilities requires the use of advanced treatment methods and the use of multiple
treatment technologies (Akpor and Muchie, 2010; Pawelczyk, 2013; Yu et al., 2018). The
environmental impact of these pollutants combined with treatment difficulties highlights the
importance of applying methods to reduce the amount of stormwater runoff and the amount of
pollution in runoff at or near the source.
The combination of emergent and persistent pollution carried to our surface waters by
stormwater runoff has prompted regulations that require stormwater discharges to meet specific
water quality standards. Green stormwater infrastructure is an attractive solution to the problem
of contaminated stormwater runoff. It creates aesthetically pleasing spaces in urban areas that
treat contaminated stormwater, while reducing the overall discharge of stormwater runoff into
waterways. GI, or stormwater best management practices (BMPs), attenuates the increasing
discharges into waterways, provides water quality treatment mechanisms, urban heat
attenuation, and ecosystem services. Vegetated BMPs function as living filters and can be part
of a treatment train for stormwater, reducing peak runoff and removing contaminants, while
providing the structure to support microbial communities and stabilize the soil. Stormwater
treatment in vegetated BMPs occurs through a combination of filtration and microbial
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bioremediation in soil media and vegetation driven bioremediation, also called
phytoremediation.
Monitoring green infrastructure (GI) vegetation can reveal signs of toxicity that may
indicate that soils have reached capacity and require removal and disposal with new installation
of soil and plants. Monitoring GI vegetation stress may also reveal changes in effluent
contaminant concentrations that indicate GI performance. When vegetated infrastructure is
used to attenuate flows and filter runoff, vegetation health plays a large role in the effectiveness
of the installation. In coastal installations, a decline in vegetation health means decreased
density and plant height, reducing the potential for wave attenuation and erosion protection
(Gedan et al., 2011). Methods for monitoring GI hydrology are well studied, including realtime methods. However, methods for monitoring the health of GI vegetation are not well
studied, including ground-based and remote methods. These methods can be valuable tools for
early detection of performance and maintenance issues.
The goal of this study is to evaluate methods for monitoring GI vegetation health. This
study evaluates one method for remotely monitoring bioretention facility vegetation health
parameters using unmanned aircraft systems (UASs) to calculate the Normalized Difference
Vegetation Index (NDVI), a measure of the reflectance in the red and near-infrared (NIR)
spectral bands. This study also explores a ground-based method of monitoring facility
vegetation health by measuring the photosynthetically active radiation (PAR) intercepted by
the vegetation canopy, a measure that is proportional to biomass production (Monteith, 1972).
These two measures are compared to explore potential relationships between the fraction of
intercepted PAR (fIPAR) and the NDVI to determine if NDVI can act as an estimate of fIPAR
and the physiological parameters derived from fIPAR at the stormwater bioretention facility.
The specific objectives of this study are outlined below.
1. Evaluate the use of a hand-held instrument for measuring PAR to obtain fIPAR at
the bioretention facility.
2. Evaluate the use of an inexpensive UAS with built-in RGB camera and external
near infrared (NIR) camera to derive an NDVI image of the bioretention facility.
3. Perform radiometric calibration using the empirical line method (ELM) and
inexpensive materials on imagery acquired with the UAS to obtain an accurate
NDVI image.
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4. Develop the relationship between ground-based measurements of fIPAR and UAS
derived NDVI. Determine if relationships exist between fIPAR and NDVI in the
bioretention facility.
5. Determine the effectiveness of fIPAR and NDVI methods for monitoring the
health of bioretention facility vegetation.
6. Evaluate benefits of NDVI temporal trend analysis for GI vegetation health and
stress monitoring.

Literature Review
Urban Stormwater Quality
Urban stormwater runoff carries various pollutants including heavy metals,
hydrocarbons, nutrients, pesticides and herbicides, bacteria and viruses, sediments, and organic
materials, making urban stormwater a primary cause of water quality impairment (USEPA,
1999). These pollutants come from a variety of point sources like industrial plants, municipal
storm sewers, and combined sewer overflows (CSOs), with many non-point sources also
contributing large pollutant loads to surface waters (USEPA, 1999). Non-point sources of
polluted stormwater runoff include highways, parking lots, agricultural, residential, and
commercial land (USEPA, 1999). Of primary concern in urban stormwater runoff are persistent
pollutants, or pollutants that remain in the environment for long periods of time after being
released. These pollutants include heavy metals, polycyclic aromatic hydrocarbons (PAHs),
persistent organic pollutants (POPs), and Perfluorinated organic compounds (PFCs), a group
of contaminants of emerging concern.
Runoff carries these contaminants into streams, rivers, lakes, and estuaries, impacting
water quality in all surface waters. These contaminants are toxic, ubiquitous, and capable of
travelling over long distances making them a primary concern for water quality treatment
efforts (USEPA, 2009; USEPA, n.d.; Davis et al., 2001). While there are many point and nonpoint sources of these contaminants, vehicle emissions are a primary source of several. The
number of registered vehicles in the United States has increased from 254.4 million in 2007 to
268.8 million in 2016, while the number of vehicle miles per year has increased from 3.03
trillion in 2007 to 3.21 trillion in 2016 (USDOT, 2018). With increasing vehicle use,
contaminants like metals, PAHs, and some POPs are present in growing concentrations in
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urban runoff. Increasing pollution levels in runoff destroys and degrades aquatic and benthic
habitats, impacting biodiversity in water bodies, as well as impacting human health by polluting
drinking water sources and recreational waters (USEPA, 1999; USEPA, 2001).

Stormwater Regulations
Several categories of regulations apply to stormwater contaminant control including
the Clean Water Act (CWA) regulations, National Pollution Discharge Elimination System
(NPDES) and 401 Water Quality Certification, and Section 6217 of the Coastal Zone Act
Reauthorization Amendments (CZARA). Driven in part by an increasing awareness of the
contaminants found in stormwater, permitting requirements increase the necessity and
attractiveness for low cost solutions like bioretention facilities and other GI, or Best
Management Practices (BMPs) that meet these permitting requirements (Simpson, 2018).
To meet the standards of the CWA, the USEPA regulates stormwater permits under
the NPDES, where Phase I permitting regulates stormwater discharges from municipalities
with a population of 100,000 or more and industrial discharges, and Phase II regulates
stormwater discharges from small municipalities serving a population of 100,000 or less and
construction activities disturbing between one and five acres (USEPA, 1999). The Municipal
Separate Storm Sewer (MS4) General Permit Remand Rule, signed into effect in late 2016
created new requirements for small communities to ensure NPDES Phase II permitting follows
the CWA standards (USEPA, 2016). New land development projects must obtain 401 Water
Quality Certification when the development may cause a potential discharge into wetlands and
waterways, with the requirement that projects minimized impacts and do not violate state or
federal water quality standards (USEPA, 2010). The Coastal Zone Management Program
requires states to develop a coastal zone management plan for managing coastal resources in
partnership with the federal government. This includes the Coastal Nonpoint Pollution Control
Program implemented by Section 6217 of the CZARA which requires states to implement
management measure to control nonpoint source pollution in runoff (USEPA, 1999; USEPA,
1993).
Regulations are primary drivers of GI, with governments acting as leaders providing
coordination and forming partnerships between government and non-governmental
organizations as well as partnerships between federal and local jurisdictions (Harrington and
Hsu, 2018). Flexibility in regulations allows for negotiation and coordination between
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stakeholders, as well as experimentation and learning through continuous monitoring of GI
(Harrington and Hsu, 2018; Chaffin et al., 2016). This can be accomplished through adaptive
management, where new data from monitoring efforts can be disseminated through the network
of regulating agencies and stakeholders to allow for feedback and potentially an adjustment of
policy (Chaffin et al., 2016). An important element of this process is long-term monitoring and
maintenance.

Remediation & Green Stormwater Infrastructure
Stormwater GI includes many types of constructed systems designed for flow control
and water quality treatment, with each type of system utilizing various treatment mechanisms.
While some structural BMPs, like detention basins, are designed to reduce peak flow rates,
vegetated systems are primarily designed for water quality control. Runoff treatment occurs in
vegetated structural BMPs in the water column of BMPs that maintain a permanent pool,
through physical and biological processes in the soil layers, or through physiological processes
in the vegetation. Many processes occur in the soil structure of vegetated BMPs, including
adsorption, sedimentation, filtration, and microbial processes that are dependent on organic
matter and moisture content of the soil layers (Nguyen et al., 2019; Deeb et al., 2018). Soils
high in clay, silt, and organic matter increase the filtration, biodegradation, and adsorption of
pollutants due to fine particle sizes increasing contact time, high nutrients promoting microbial
growth, and high cation exchange capacity (CEC), or amount of negatively charged bonding
sites on soil particle surfaces (Li and Davis, 2009). Filtration and adsorption are primary
removal mechanisms for metals, PAHs, POPs, and PFASs (Hatt et al, 2011; Machate et al.,
1997; Howell et al., 2011; Felizeter et al., 2012).
Vegetation plays many important roles in structural BMPs. Vegetation provides
nutrients to the microbial communities in the soil and maintains soil permeability, while taking
up contaminants that infiltrate the soil in stormwater runoff (Akpor and Muchie, 2010). Dense
vegetation filters stormwater runoff by reducing the flow velocity, allowing particles to settle
out of the water (USEPA, 1999). Many studies have shown that an increase in contaminant
loads resulted in an increase in removal, especially for plant uptake (Sun and Davis, 2007;
Lucke and Nichols, 2015; NRMRL, 2002). Vegetation also treats contaminated stormwater by
supporting microbial growth essential to degradation of organic pollutants through a process
called phytostimulation, where vegetation root exudates provide carbon and energy used by
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microorganisms (Akpor and Muchie, 2010; Favas et al, 2014). Root systems support the soil
structure in bioretention systems, maintaining soil permeability (Dagenais et al., 2018). Roots
also immobilize contaminants including metals and organics through absorption into root cells,
adsorption to exterior root surfaces, or precipitation into the soil matrix by root exudates in a
group of processes called phytostabilization or phytoimmobilization (Akpor and Muchie, 2010;
Felizeter et al., 2012; Favas et al., 2014; Hooda, 2007).
Most metals in stormwater runoff that are not removed by soil media may be treated
through phytoremediation mechanisms including phytoextraction, where metals accumulate in
plant tissues, or phytostabilization, where metals are immobilized and contained in the
rhizosphere, or root zone of the vegetation (Favas et al., 2014). Metal uptake occurs through
root tips due to a concentration gradient across the root membrane, or through protein transport
across the membrane (Hooda, 2007). Low metal solubility and high soil CEC minimizes metal
bioavailablity to plants reducing plant uptake and accumulation, but fungal and bacterial
activity can increase root uptake of metals (Hooda, 2007). Additionally, certain species of
plants have an affinity for certain metals, with the ability to hyperaccumulate metals in shoots
(Hooda, 2007).
When hydrocarbon contaminants in stormwater runoff are not removed by soil media,
treatment is possible with rhizodegradation, or the process through which plants and
microorganisms break down organic contaminants in the rhizosphere into alcohols, carbon
dioxide, acids, and water through a symbiotic relationship (D’Souza et al., 2015).
Rhizodegradation is the most common mechanism for treating organic compounds with plants,
including PAHs and potentially PFASs, but phytodegradation, phytostabilization,
rhizofiltration, and phytovolatilization also play a role (Favas et al., 2014; Arvanaghi et al.,
2017; Felizeter et al., 2012). Rhizofiltration occurs when PAHs and PFASs accumulate in the
roots of studied plants with very little transport to shoots, and phytodegradation is the process
by which plants uptake contaminants and transform them through metabolic processes in the
plant tissues (D’Souza et al., 2015; Arvanaghi et al., 2017). Rhizodegradation plays an
important role in degrading polychlorinated biphenyls (PCBs), where flavonoids released by
plant roots increase microbial degradation (D’Souza et al., 2015). This applies to DDT as well,
but daughter products of DDT degradation are also toxic and persistent in the environment
(D’Souza et al., 2015).
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Specific toxic effects of metal and organic contaminants on plants have been shown in
various studies. Heavy metal accumulation in plant tissue can result in decreased
photosynthetic activity in plants, degraded chloroplasts and decreased chlorophyll production,
stomatal closure, and decreased transpiration, which may present as decreased growth,
chlorosis, and necrotic lesions (Dietz et al., 1999; Prasad and Strzalka, 1999; Shaikh et al.,
2013). Pb and Cd toxicity in plants is shown to decrease photosynthesis, respiration, and overall
growth, at least partly through increased stomatal resistance, or increased stomatal closure
(Sharma & Dubey, 2005; Prasad and Strzalka, 1999). Similar effects can be seen with other
metals at toxic concentrations, depending on whether the metals are essential to plant growth,
or non-essential (Lugli and Mahler, 2016; Rengel, 1999). Physiological effects of PAH uptake
on plants are similar to metal uptake at high concentrations, including a reduction in plant
biomass, growth, chlorophyll pigments, photosynthetic activity, stomatal conductance, and
chlorophyll fluorescence, as shown in a study of two PAHs, phenanthrene (PHE) and pyrene
(PYR) (Jajoo et al., 2014; Ahammed et al., 2012).
Systems that incorporate vegetation and encourage biological activity increase
pollutant removal efficiency. The National Pollutant Removal Performance Database provides
the combined statistics of 166 studies of efficiencies for BMPs giving the percent of pollutants
removed based on measurements at the inflow and outflow of the BMP (2007). Nutrients, total
suspended solids (TSS), bacteria, copper and zinc were included in the removal analysis of
specific types of BMPs including dry ponds, wet ponds, wetlands, organic and sand filters,
infiltration trenches, porous pavement, bioretention basins, and grass swales (Fraley-McNeal
et al., 2007). Wet ponds, wetlands, filters, infiltration BMPs, and grass swales showed the
highest median removal of TSS, ranging from 72% to 89% (Fraley-McNeal et al., 2007).
Bioretention basins (81%) and infiltration BMPs (86%) have the highest median removal of
Cu, while filters (87%) and bioretention basins (79%) have the highest median removal of Zn
(Fraley-McNeal et al., 2007). Bioretention basins have also been shown to effectively remove
Cr, Cd, and Pb (Li and Davis, 2009). Bioretention removal rates in one study showed 94%
removal of Zn, 88% removal of Cu, 95% removal of Pb, and greater than 95% removal of Cd,
primarily through filtration and adsorption mechanisms in bioretention media (Sun and Davis,
2007).
Vegetation plays an important role in the effectiveness of GI systems. To support the
fully functional performance of vegetated GI, vegetation health monitoring practices must be
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established. Monitoring the health of vegetation in stormwater green infrastructure can indicate
signs of pollutant induced toxicity, water stress, and disease. Early detection of stress in
vegetation can inform management and maintenance decisions. It is important to consider the
long-term effectiveness of GI when there is the potential for buildup of sediments and
contaminants in media and vegetation, potentially reducing effectiveness and increasing the
likelihood of desorption of contaminants, or pollutants being released from media during storm
events (Lucke and Nichols, 2015). A primary consideration to improve the performance of GI
is long-term monitoring and maintenance.

Facility Monitoring
GI monitoring and maintenance in urban areas is a challenge for responsible parties over
the long term, especially for small GI installations (Keeley et al., 2013). Monitoring the
hydrology, hydraulics, and water quality in GI is well studied, while methods for monitoring
the status of GI vegetation are poorly studied. Many methods for determining the performance
of a GI facility through monitoring are detailed in guides like the US EPA’s BMP monitoring
manuals, including the Urban Stormwater BMP Performance Monitoring: A Guidance Manual
for Meeting the National Stormwater BMP Database Requirements (2002) and the Urban
Stormwater BMP Performance Monitoring report (2009b). However, methods for monitoring
vegetation in GI in these manuals is limited to the identification, location, and description of
vegetation density and height with no detailed methodology included beyond a visual
inspection of these elements (USEPA, 2002; USEPA, 2009b). These manuals inform
municipalities of procedures for monitoring GI with guidance on developing GI monitoring
plans.
Intelligent systems incorporating real-time data and smart control systems optimize
monitoring and maintenance efforts on several levels (Quigley and Brown, 2014). Real-time
data provides insight into system performance during events, allowing for early identification
of maintenance issues and real-time performance analysis (Kerkez et al., 2016). Real-time data
allows for monitoring flow rates, stage, precipitation, soil moisture and exfiltration during
storm events to determine facility performance (Kerkez et al., 2016; Razzaghmanesh et al.,
2019). Smart internet-connected control systems can be utilized directly to control system
outflows by actively tailoring downstream hydrographs to reduce erosion, empty stormwater
ponds to increase storage space, and increase detention times to reduce pollution loads in
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outflows (Kerkez et al., 2016; Mullapudi et al., 2018). A survey of professionals in stormwater
agencies in the United States showed that there is a preference to invest in smart GI due to
lower maintenance costs (Meng and Hsu, 2019).
Intelligent GI systems allow for monitoring and control of flows and subsurface
conditions primarily, but do not provide the means to monitor vegetation growth and health in
GI. There are many potential methods for monitoring vegetation in GI facilities, including
remote sensing. Remote sensing technology holds the potential for monitoring GI vegetation
health and effectiveness. Remote sensing utilizing satellite systems and aerial systems has been
applied to study GI vegetation for various purposes. Many studies of GI using remote sensing
systems have explored the cooling effects of urban green areas where various types of remote
sensing data have been utilized including multispectral, hyperspectral, and light detection and
ranging (LiDAR) data (Bartesaghi-Koc et al., 2017; Gaitani et al., 2017; Bartesaghi-Koc et al.,
2019). This data is then used to detect surface emissivity using thermal infrared (TIR),
vegetation indices (VIs) using multispectral and hyperspectral data, and classifications like
land-use land-covers (LULC) derived from LiDAR and imagery (Bartesaghi-Koc et al., 2017;
Gaitani et al., 2017; Bartesaghi-Koc et al., 2019).
Studies of urban greenness and canopy cover performed with vegetation indices
derived from aerial imagery and GIS, and measures of vegetation density found using
unmanned aircraft system (UAS) imagery of urban green spaces are intended to assist with
valuing urban green areas and planning for design and maintenance (Franco and Macdonald,
2018; Gadi et al., 2018). Additionally, remote sensing imagery was utilized in studies relating
urban GI and green spaces to stormwater runoff reduction, primarily to determine the
effectiveness of GI in mitigating flood events (Kim et al., 2017; Lee, 2018). While remote
sensing methods have been explored for many purposes in urban green areas, there is limited
research on the application of these methods in vegetated stormwater facilities.
Remote sensing technology is commonly applied in the agriculture industry for lowcost assessment of vegetation health and overall site monitoring. Remote sensing methods are
used to assess crop health and stress through vegetation indices like the normalized difference
vegetation index (NDVI), the normalized difference between the NIR and red wavebands. The
NDVI is related to various vegetation parameters including green biomass, fraction of
intercepted photosynthetically active radiation (fIPAR), leaf area index (LAI), leaf chlorophyll
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content, transpiration, and senescence (Rouse et al., 1974; Glenn et al., 2008; Prueger and
Hatfield, 2010; Doughty and Cavanaugh, 2019). NDVI derived from satellite and UAS data
has been used to map and monitor natural and engineered systems with a variety of purposes.
NDVI derived from UAS waveband data was successfully used to detect vegetation
health and disease of green spaces in an urban area of Bulgaria (Dimitrov et al., 2018). Satellitederived NDVI was used to map efficient wetlands, while UAS-derived NDVI was used to
create biomass maps of salt marshes (Rapinel et al., 2019; Doughty and Cavanaugh, 2019).
Remote sensing methods and VIs have also been applied to detect the presence of
contaminants, like trinitrotoluene (TNT), in soils, and to detect changes in the reflectance of
plant leaves when the plants have been used for phytoremediation of metal contaminated soils
(Naumann et al., 2009; Rathod et al., 2015). NDVI was used to successfully detect signs of
stress in treatment peatlands for monitoring purposes (Isokangas et al., 2019). Additionally,
NDVI has been shown to have a strong relationship to above ground biomass in wet sedge
tundra regions and has successfully been used to monitor vegetation in these regions (Goswami
et al., 2015; Boelman et al., 2003). The Maryland Department of Transportation (2016) has
studied the use of satellite derived NDVI for determining the performance of GI installations,
without success. These studies indicate that remote sensing methods and vegetation indices like
NDVI can be developed as a viable method for monitoring GI health and potentially the
response of plants to sources of stress.
The fraction of intercepted photosynthetically active radiation (fIPAR), the amount of
PAR, solar radiation in the spectral range of 400 – 700 nm, intercepted by vegetation, is a useful
measure of vegetation growth and a potential method for monitoring biomass production in GI.
The fIPAR has been shown to have a strong correlation with dry biomass production, or net
primary productivity (NPP) and is used in models of dry matter production efficiency and
radiation use efficiency (RUE) (Monteith, 1972; Monteith, 1977; Rosati and Dejong, 2003).
The fIPAR is also considered an essential plant parameter for defining functional groups used
in process-based models and was used to define functional groups for wetlands in several
representative wetland regions in the US (Williams et al., 2017). Additionally, the fIPAR has
been shown in research to correlate with VIs, specifically NDVI. Studies show that the fIPAR
and NDVI have a linear relationship when applied to row crops and prior to the onset of
senescence in sampled vegetation (Hatfield et al., 1984; Serrano et al., 2000). This indicates
that NDVI may provide an estimate of fIPAR and biophysical parameters related to fIPAR.
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While the use of NDVI and fIPAR for monitoring or detecting change in crops and
natural systems are well studied, there is a lack of knowledge about the effectiveness of
monitoring these parameters as indicators of stress and health of vegetation in engineered
systems, specifically stormwater GI systems. Implementation of remote technology to monitor
GI vegetation growth and health may provide insight into vegetation-dependent performance
while informing maintenance decisions. Fast detection of physiological changes in vegetation
may provide indications of exposure to new or altered contaminant loads, signs of senescence
and disease, water stress, or other stressors requiring planning for treatment or removal/disposal
and replacement of vegetation and possibly soil media.
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Methodology
Site Description
The study was conducted at the OSU-Benton County Green Stormwater Infrastructure
Research (OGSIR) Facility, an Oregon BEST Lab, installed in 2014 and situated on the corner
of the Benton County Development Department property in Corvallis, Oregon, as shown in
Figure 1. OGSIR is a field research facility for testing GI installations that captures runoff from
approximately 100,000 square feet of catchment area in the County property as shown in Figure
2. The county property is a maintenance and service facility that is representative of many
industrial sites used for parking, storage, and refueling county vehicles and storage of
construction materials and equipment.

Figure 1: Vicinity map of the OGSIR bioretention facility in Corvallis, OR
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The

average

annual

precipitation in Corvallis, Oregon is
about 43 inches. The catchment area
generates approximately 2.7 million
gallons annually, which is routed
through the bioretention facility for
treatment. Stormwater runoff from this
catchment carries pollutants like tractor
leaks, fuel tank spills, raw asphalt, road
fill sediment, parking lot sediments and
chemicals, road paint spills, and more.
Runoff is captured by catch basins in
the catchment area, conveyed to a
1,500 gallon in-line underground

Figure 2: OGSIR facility and catchment area
showing flow paths and sources of pollutants.

storage tank before being pumped into an above ground sediment bay, allowing particles to
settle out of the runoff. When the sediment bay is full, the runoff flows over 4-inch-high, 45O
v-notch weirs, with each weir allowing runoff to flow into one of the three bioretention cells.
Figure 3 shows the flow paths through the system.

Figure 3: Schematic of OGSIR bioretention facility (Livingston, 2015)
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Each bioretention cell is approximately 93.4 feet long, 10.5 feet wide, 3 feet deep with
a six-inch perforated underdrain placed in a trench in the bottom center of each cell. The bottom
of each cell is covered with a pond liner to isolate the system from groundwater. The cells have
4:1 (H:V) side slopes with three feet of soil media at the edges and 27 inches of soil media in
the center. They contain amended soil to a depth of 18 to 27 inches, followed by three inches
of coarse sand, three inches of crushed gravel with three inches of uniformly graded river rock
at the bottom. Runoff flows down the center of the cells, infiltrating the soil and entering the
underdrain, which then conveys the stormwater to outlet works connected to the City of
Corvallis storm drain system and ultimately to the Willamette River.
Real-time sensors that continuously log data are located throughout the cells, including
pressure sensors to monitor water depth in the cells, soil moisture sensors, soil matric potential
sensors, as well as a complete weather station, as shown in Figure 4. Yearly infiltration tests
are performed in the active cells to detect changes in soil permeability due to fine sediments
carried into the cells by runoff. Water quality testing at the inflow and outflow is used to detect
the overall efficiency of the facility for treating stormwater from the catchment.

Figure 4: OGSIR facility schematic showing locations of sensors (Livingston, 2015).
Vegetation was selected for installation in cells 2 and 3 of the facility based on the
geographic region. These plants include a mixture of grasses, sedges, rushes, and broad leaf
shrubs able to withstand wetland conditions. Cell 2 was planted primarily with sedges, rushes,
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and grasses and Cell 3 was planted with a mix of vegetation. The plantings in both cells are
irregular with some of the vegetation dying between the planting date in the summer of 2014
and the data collection dates in the summer of 2019. The two cells have heterogenous canopies
due to the irregular plant locations and variations in plant health and species, with bare areas
dominated by weeds during the spring and dry grass during the summer. The complete list of
vegetation originally planted in the bioretention cells is given in Table 1. Vegetation parameters
were measured in the field and remotely, focusing on specific areas in the two bioretention
cells.
Table 1: Vegetation originally planted in the OGSIR bioretention cells in 2014
Botanical Name
Achillea millefolium
Camassia quamash
Carex densa
Carex obnupta
Danthonia californica
Deschampsia cespitosa
Fragaria virginica
Gaultheria shallon
Juncus patens
Lupinus polyphyllus
Mahonia repens
Mimulus guttatus
Potentilla gracilis
Rosa nutkana
Saxifraga oregana
Scirpus acutus
Sidalcea campestris
Symphoricarpos albus

Common Names
Common Yarrow
Common Cammas
Dense Sedge
Slough Sedge
California Oatgrass
Tufted Hairgrass
Wild Strawberry
Salal
Spreading Rush
Bigleaf Lupine
Creeping Barberry
Seep Monkeyflower
Slender Cinquefoil
Wild Rose
Oregon Saxifrage
Hard stem Bulrush
Meadow Checkerbloom
Common Snowberry

Fraction of Photosynthetically Active Radiation (fIPAR)
Field measurements were collected within 2 hours of noon with the Accupar LP-80
ceptometer, shown in Figure 5, a hand-held instrument with 80 PAR sensors that measure
photosynthetically active radiation (PAR), light in the 400 – 700 nm spectral range (Meter
Group, n.d.). PAR readings from the probe are divided into 8 segments of sensors down the
32-inch length of wand, assumed to be spaced evenly, with segment 1 closest to the controller

16
and segment 8 farthest from the controller. Coordinates of PAR measurements were acquired
with real-time kinematic GNSS methods. A Leica GS 14 GNSS antenna was used to collect
coordinates at the center of each AOI with an accuracy of under 0.10 ft (Leica Geosystems,
n.d.). Areas of interest (AOIs) included a random selection of plants from the sedge, rush,
grass, and broad leaf plant groups.

Figure 5: Accupar LP-80 ceptometer in use at the
OGSIR facility.

Figure 6: Ceptometer wand
orientations, plant canopy, location
of GNSS antenna, and AOI.

At each AOI, the GNSS antenna pole was placed at the center point and PAR
measurements were taken above the canopy and below the canopy simultaneously, carefully
avoiding shading the sensors during measurements. Measurements were taken using a variation
on the Plant Method described by Johnson et al. (2010). To reduce the effects of directionality
and canopy heterogeneity on measurements, measurements were taken in four directions (N-S,
E-W, NE-SW, NW-SE) and with each measurement centered in the middle of the AOI, as
shown in Figure 6. 32 measurements were acquired both above and below the canopy at each
AOI. The averaged above and below canopy measurements were used to calculate the fIPAR
as shown in Equation 1:
𝑓𝐼𝑃𝐴𝑅 = 1 −

𝑇
𝑆

(1)

where T is the PAR transmitted through the canopy, or the below canopy PAR measurement,
and S is the incident PAR at the canopy, or the above canopy PAR measurement (Serrano et
al., 2000; Meter Group, n.d.).
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Unmanned Aircraft System (UAS) Data Acquisition and Processing
Imagery was collected with two separate drones on
three occasions, at the beginning of June, end of June and
end of July in 2019. Each flight occurred within 2 hours of
noon. Acquisition of fIPAR data corresponded with dates
and times of drone flights.
The

first

set

of

imagery

was

acquired

simultaneously with the built-in camera on a DJI Mavic Pro
UAS and a MAPIR Survey3N NIR camera mounted
externally on the Mavic Pro, as shown in Figure 8 (DJI,
2017a; MAPIR, 2017). The two other image sets were
acquired similarly with a Phantom 4 Pro UAS with the
Survey3N NIR camera mounted externally, also shown in
Figure 8 (DJI, 2017b). Imagery was acquired at an
approximate altitude of 70 ft above the rain garden at 4 mph
with 95% front and side overlap, in a lawn mower pattern
as shown in Figure 7. The extra overlap ensures that the NIR

Figure 7: UAV flight path
used for image acquisition on
June 29, 2019.

camera mounted to the front of the two drones will also have
acceptable overlap.

Figure 8: DJI Mavic Pro (left) and DJI Phantom 4 Pro (right) both showing the
externally mounted MAPIR Survey3N NIR camera.
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The DJI Mavic Pro has a 12 MP camera with a focal length of 5 mm, a lens FOV of
83o, CMOS sensor size o 1/2.3”, and imagery was captured at ISO-100 with a shutter speed of
1/661 seconds (DJI, 2017a). The DJI Phantom 4 Pro has a 20 MP camera with a focal length
of 9 mm, a lense FOV of 84o, CMOS sensor size of 1”, with imagery captured at ISO-100 and
a shutter speed of 1/320 seconds (DJI, 2017b). The Survey3N NIR 12 MP camera has a focal
length of 8 mm, 41o FOV, with imagery captured at ISO-400 with a shutter speed of 1/500
seconds (MAPIR, 2017). The Survey3N takes pictures every 0.5 seconds during flight and
saves pictures in RAW image format (MAPIR, 2017). Using the MAPIR Camera Control
software, the data from the image RAW files and GNSS data stored with the image files are
combined and JPG images are created for structure-from-motion processing with Web
OpenDroneMap (WebODM) (WebODM, n.d., Ramseyer, n.d.).
The orthomosaics are generated at a resolution of 1 cm/pixel, a resolution selected to
limit distortion in the orthomosaic and provide sufficient detail for further analysis. WebODM
is an open source drone mapping software package that produces orthorectified maps, point
clouds, and digital surface models (DSMs) from aerial images using image processing libraries
including OpenSfM and Primordial Machine Vision Systems (PMVS) (WebODM, n.d.;
Zecevic et al., 2017). Using the web-based graphical user interface of WebODM and default
settings for high resolution orthomosaic generation, two orthomosaics were generated from
each flight, one from either the Mavic Pro or Phantom 4 Pro RGB CMOS camera, and one
from the Survey3N NIR camera.

Radiometric Calibration
Spectral Data Acquisition
Reflectance spectra were acquired with the OceanOptics Flame-S spectrometer and the
OceanView software (Ocean Optics, 2015; Ocean Optics, 2013). The instrument covers the
VIS and NIR spectral range (350 nm – 1000 nm), has an optical resolution (full width at half
maximum) of 1.34 nm, and a sampling interval of 0.37 nm. An optical fiber with a 25o field of
view (FOV) transfers light into the spectrometer.
Calibration targets must meet several requirements. The size of the target must be
several times larger than the pixel sizes of the cameras, near-Lambertian, horizontal, spectrally
homogeneous, and cover a range of spectral values (Smith and Milton, 1999; Haghighattalab
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et al., 2016). Easy to acquire and inexpensive targets that meet these requirements include matte
ethylene-vinyl acetate (EVA) foam panels. The matte EVA panels are diffuse reflectors and
have highly Lambertian behavior and horizontal homogeneity (Padro et al., 2018; Jeong et al.,
2018).
The calibration procedure was performed within 2 hours of noon on a clear, sunny day
at the study site using 9.4 x 9.4-inch white, gray, and black matte EVA foam calibration panels
mounted to black canvas and separated by several inches to reduce adjacency and background
effects (Padro et al., 2018). These panels are many times larger than the pixel sizes (1 cm/
pixel) of the imagery used for calibration. Reflectance measurements were taken from 2 -3
inches above each panel at a 45-degree angle (OceanOptics, n.d.). Prior to measurements of
each panel reflectance, dark measurements and diffuse white reflectance standard
measurements were taken. Reflectance measurements are normalized with the white reference
standard, or the light incident on the calibration panel surface (OceanOptics, n.d.).
Seven to eight measurements were collected from different angles above each panel
between 11:10 am and 11:20 am on a clear, sunny day on June 15, 2019. This reflectance data
set was used to calibrate imagery from three dates June 1, June 29, and July 27, 2019 with the
assumption that no changes to the calibration panels have occurred through this time span that
would affect reflectance. To eliminate the temperature changes caused by using the instrument
in the direct sun, the instrument was placed in an insulated housing during data collection.
Figure 9 shows the simple insulated housing used to protect the spectrometer during data
acquisition. The temperature inside the insulated housing was recorded immediately preceding
the start of spectra collection for the white calibration panel, between the collection of spectra
for each panel, and after all spectra were collected.
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Figure 9: Spectra collection set up showing the insulated housing, calibration panels, and
sensors.

Empirical Line Method
Following the procedures given by Wang and Myint (2015), the 7-8 reflectance spectra
acquired for each of the three calibration panels were plotted and the mean reflectance curve is
found. The spectral ranges corresponding to typical CMOS digital cameras and assumed to
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apply to the Mavic Pro and Phantom 4 Pro cameras are 580 – 670 nm for the red band, 480 –
610 nm for the green band, and 400-520 nm for the blue band (Hunt et al., 2013). The
wavelength corresponding to the MAPIR Survey3N NIR camera is 850 nm (Ramseyer, n.d.).
To perform the empirical line method (ELM), the mean reflectance value corresponding to the
spectral ranges of the UAS camera wavebands were found and plotted for each calibration
target (Wang and Myint, 2015).
Using zonal statistics in ArcMap 10.6, the mean pixel values (DNs) were extracted
from the orthophotos for each of the four bands (ESRI, 2018). Only the central pixel values of
each calibration target were extracted from the orthophotos to avoid boundary effects and the
mean digital number (DN) was found (Smith and Milton, 1999; Wang and Myint, 2015;
Haghighattalab et al., 2016). The polygons used for extraction are shown in Figure 10. When
image distortions were present at calibration panel locations, then mixed pixels were carefully
avoided by using a modified polygon shape.

Figure 10: Calibration panels with polygons for extracting mean pixel values
(digital numbers) using ArcMap Zonal Statistics
The mean DN of each target in the orthomosaics was plotted against the mean
reflectance value obtained from the spectrometer measurements for each camera waveband,
where each point in the plot represents a different calibration target (Wang and Myint, 2015).
The resulting regression models were used to determine the calibration parameters (the yintercepts) for each waveband (Wang and Myint, 2015). The equations were then applied to
the individual bands using the ArcMap Raster Calculator. When the calibration parameters are
below zero, this results in a minimum reflectance of zero and excludes the darker DN values.
A conditional statement was used in ArcMap Raster Calculator to exclude the negative DN
values from the bands. This is repeated with each image set, where unique regression models
were generated from the reflectance data for each calibration panel and the DN values obtained
from the bands in each image set.
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Normalized Difference Vegetation Index (NDVI)
Prior to creating the NDVI maps, each band of the NIR and
RGB orthomosaics was georeferenced to control points set during a
2014 survey at the four corners of the rain garden, as shown in Figure
11. The calibrated and georeferenced bands can be combined using
the ESRI ArcMap Composite Bands tool to create NDVI maps using
the Image Analysis tool. Healthy leaves produce an abundance of
chlorophyll pigments, which absorb highly in the red part of the
spectrum (Knipling, 1970). However, chlorophyll pigments have no
effect on the absorption or reflectance in the NIR. Instead, the
structure of the leaves, specifically the spongy mesophyll and air
cavities, is responsible for the high reflectance in the NIR part of the
spectrum, where NIR light is scattered and reflected (Knipling, 1970).
An example of the expected reflectance for healthy vegetation
is shown in Figure 12, where reflectance and transmittance are shown
and the difference between them is the absorbance. This shows that
absorption is high in the red part of the spectrum and reflectance is

Figure 11: RGB
orthomosaic showing
the control points
surveyed in 2014.

high in the near infrared part of the spectrum. NIR reflectance is much
higher than all reflectance in the visible part of the spectrum. The same relationship should be
seen in the brightness values of the image pixel spectra.
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Figure 12: Spectral response of a representative example of healthy vegetation. (Jacquemoud
and Ustin, 2008)

The NDVI, Equation 2, is the normalized difference between the near infrared band
and the visible red band, where the DN values are calibrated to relate to the physical reflectance
in the image color bands (Gamon et al., 1995).
𝑁𝐷𝑉𝐼 =

𝐷𝑁𝑁𝐼𝑅 − 𝐷𝑁𝑅𝑒𝑑
𝐷𝑁𝑁𝐼𝑅 + 𝐷𝑁𝑅𝑒𝑑

(2)

NDVI values are floating point numbers ranging from -1 to 1, where negative values
indicate the presence of water or possibly wet soil, values close to zero indicate soil or dead
vegetation, values in the low positive range indicate stressed vegetation and values in the high
positive range represent healthy vegetation (Weler & Herring, 2000). A NDVI colormap was
also generated for each image set showing high NDVI values as green and low NDVI values
as brown.
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Data Analysis
Regression Analysis
The relationship between the NDVI derived from the
UAS imagery and ground-based measurements of the fIPAR
was explored using an orthomosaic and the corresponding
fIPAR measurements acquired at the end of June based on
Gamon et al. (1995). Circular AOIs with 32-inch diameters
were created by the four Accupar LP-80 measurements at each
point, as shown in Figure 6. The mean of all NDVI pixel values
falling within each AOI was extracted. Figure 13 shows the
location of 41 AOIs in the two bioretention cells.
A regression analysis was performed on the full 41
points to explore the correlation between fIPAR and NDVI for
the active cells in the bioretention facility. The data points were
subset by cell and into the sedge, rush, and broad leaf vegetation
groups. A regression analysis was then performed on each
group.

Spatial Analysis
NDVI and fIPAR values were examined for spatial
trends related to proximity to the bioretention cell inlets, the
primary source of water during the spring growing season. As
water is conveyed down the length of the cells, it infiltrates and

Figure 13: Orthomosaic
with locations of data
points and areas of interest
(AOIs) in both bioretention
cells.

enters the underdrain. During the summer, drip irrigation is
used to supplement runoff. To determine if the proximity to the inlet is related to the health of
vegetation, the values of NDVI and fIPAR were related to the distance from the inlet. The
relationship between fIPAR and the distance from the inlet was examined for all 41 sampling
locations. fIPAR values from two dates were compared for bioretention Cell 3 and the
relationship between fIPAR values and the distances from the inlets in Cells 2 and 3 were
examined for the June 29, 2019 data set. NDVI values were extracted from all three cells using
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ArcMap polygons, where sectional polygons were drawn to include all vegetation growing in
each cell where the canopy may overlap other cells as shown in Figure 14.

Figure 14: The polygons to extract NDVI data moving away from the inlets of the three
bioretention cells (left) and the polygons used to extract NDVI class data for each of the three
cells (right) on all dates.

Temporal Trend Analysis
Temporal trend analysis examines NDVI data from the summer of 2019, with samples
taken monthly at the end of May, end of June, and end of July. Polygons, shown in Figure 14,
encompassing each of the three bioretention cells and the vegetation growing over the boundary
of each cell were used to extract NDVI data. NDVI data within set ranges of values were
extracted to examine how the area of coverage changes for each NDVI range over the course
of the two months. The ranges of NDVI values explored were 0.8 – 1.0, 0.6 – 0.8, 0.4 – 0.6,
0.2 – 0.4, 0.0 – 0.2, -0.2 – 0.0, -0.4 – (-0.2), -0.6 – (-0.8), -0.8 – (-1.0). These ranges were
grouped to represent vegetation health status and the presence of soil or lack of vegetation.
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Results and Discussion
Fraction of Intercepted Photosynthetically Active Radiation (fIPAR)
Spatial Analysis
Figure 15 shows the classified fIPAR values overlaid on RGB orthomosaics for one
cell of the bioretention basin on June 15, 2019 and two cells on June 29, 2019. Figure 16 shows
fIPAR values in relation to the distance from the inlet to each cell. When examining the fraction
of intercepted radiation in relation to the distance from the inlet, there is very little change as
the distance between the sample points and the inlet increases. However, there are more points
with higher fIPAR values closer to the inlet and more with moderate to low fIPAR values
farther from the inlet. However, the fraction of intercepted radiation is not consistently high for
vegetation that appears healthy or low for vegetation that appears unhealthy. Although
vegetation appears unhealthy, many species of grasses are dormant in the summer months
indicating that these species may retain density during dormancy. Without differentiating

N
June 15 fIPAR (left)

June 29, 2019 (right)

Figure 15: Classified fIPAR at 18 AOIs for June 15, 2019 and 41 AOIs for June 29, 2019
overlaid on RGB orthomosaics from imagery obtained on these two dates.
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between unhealthy and dormant, and how dormancy of vegetation species present in facilities
affects vegetation density, fIPAR values cannot be reliably used as an indicator of vegetation
health. It should be noted that the range of fIPAR values is over 0.50, or more than 50% of
light is intercepted by vegetation, on both dates, with no values lower than 0.60 on June 29,
2019 and no values below 0.52 on June 15, 2019.
fIPAR in relation to inlet Cell 3

June 29 fIPAR in relation to inlet Cells 2 and 3
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Figure 16: fIPAR values related to the distance to the inlet, primary water source. The left
fIPAR plot shows fIPAR values for cells 2 and 3 on June 29, 2019 and the right plot shows
only fIPAR values for Cell 3 for June 15 and June 29, 2019.
Sedges and rushes are common species in GI and present in the OGSIR facility. The
mean fIPAR value obtained on June 29, 2019 for a sample of eight sedge plants in the OGSIR
facility as shown in Figure 17, including slough and dense sedge species, is 0.92. The mean
fIPAR value for seven rush plants sampled in the facility at the same time, as shown in Figure
18, including hardstem bulrush and spreading rush species, is 0.85. fIPAR values for slough
sedge, hardstem bulrush and poverty rush sampled from natural stands in four different
wetlands in the United States, two wetlands in Texas, one in Delaware, and one in North Dakota
are 0.67, 0.32, and 0.47, respectively (Williams et al., 2017).
As an essential plant parameter used in process-based models, fIPAR values were used
to develop functional groups to aid in modeling, where plant parameters were used to group
wetland vegetation species into two functional groups, low leaf area index (LAI) plants and
high LAI plants (Williams et al., 2017). LAI is a measure of the leaf area in a canopy per unit
of ground surface and high LAI results in high fraction of intercepted PAR. Slough sedge and
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poverty rush fell in the high LAI functional group, while hardstem bulrush fell into the low
LAI functional group (Williams et al., 2017). However, the values obtained in the natural
wetlands are much lower than those obtained in OGSIR’s engineered environment. This would
indicate that sedge and rush vegetation is denser in engineered systems than natural systems.
The fIPAR values obtained in the OGSIR facility would indicate high LAI. However, fIPAR
values of wetland species or species commonly used in GI are seldomly reported in literature.

N

Figure 17: Locations of sampled sedge vegetation in the OGSIR facility and associated
fIPAR values.

N

Figure 18: Locations of sampled rush vegetation in the OGSIR facility and associated fIPAR
values.

Method Evaluation
There are many challenges in obtaining reliable PAR results in the bioretention cells
at the OGSIR facility potentially resulting in biased fIPAR measurements. The geometry of the
bioretention cell cross-section is trapezoidal with side slopes of 4:1 (H:V). Obtaining level PAR
measurements in four directions beneath the canopy of shrubs requires compensating for this
side slope by raising the Accupar wand and obtaining measurements within instead of entirely
beneath the canopy. This also occurs close to the bioretention cell walls, where the height of
the walls requires raising the wand to acquire level measurements. This results in an
underestimate of fIPAR, where the Accupar sensors are not detecting the radiation intercepted
by the entire canopy, but only part of the canopy. The opposite occurs when obtaining
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measurements next to wells and other obstructions in the bioretention cells. In this case, some
AOI measurements include shadows from these obstructions, creating an overestimate of the
fIPAR at the AOI.
Challenges also occur from structural differences between species and from the use of
a GNSS unit to obtain coordinates at AOI center points. The rushes and sedges form dense
clumps at the ground level instead of woody stems common below the canopies of shrubs.
Pushing the Accupar wand through the clump at the base of sedges and rushes disturbs the
plant, changing the structure of the plant and the resulting PAR measurements. Placing the
GNSS antenna pole into the center of plants selected for AOIs also disturbs the plant canopy
and acts as an obstruction, casting a shadow during measurement. While instrument operators
minimized disruption to the vegetation while obtaining measurements, some areas of the
facility have very dense vegetation where it is necessary to disturb vegetation in order to place
the instruments. Disturbing the vegetation canopy results in biased measurements.
To collect data for 41 AOIs in this small GI facility takes several hours of field labor
with minimal processing time. The larger the GI facility, the more manpower and more
instruments are necessary to acquire sufficient data to use this method to monitor GI vegetation
health. The combined cost of purchasing the Accupar LP-80 and GNSS smart antenna and
controller for a small facility, and the manpower and additional cost of more instruments
required to scale this method to larger GI facilities reduces the feasibility of this monitoring
method. Considering the likelihood of obtaining biased data and the cost of scaling the method,
using a ground-based fIPAR method for monitoring GI is ineffective.
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UAS Imagery
Figure 19 shows the orthomosaics generated with WebODM from the imagery
acquired on June 1, 2019, June 29, 2019, and July 27, 2019. The June 1 and June 29 image sets
were acquired in full sun while the July 27 image set was acquired in overcast conditions. The
images are high quality at 1 cm/pixel, with minimal distortion. The camera settings were
constant between flights having the same UAS configuration, but the light conditions were
different on each date resulting in the brightness of the orthomosaics differing between dates.
These images show the importance of calibrating the imagery to ground-based reflectance data
so that each image in the multitemporal data set contains consistent values.
Acquiring UAS imagery in the field requires minimal time and effort. The OGSIR
flights were each completed in under an hour. This includes set-up and break-down time and
acquiring one to two backup data sets. The two UASs used for the three flights produced good
quality data, with minimal distortion in the final orthomosaics obtained from both the DJI
Mavic Pro and the DJI Phantom 4 Pro data sets. The DJI Mavic Pro cost about four times less
than the DJI Phantom 4 Pro. Data processing times vary by camera, with the NIR data sets
processing in 1 – 2 hours and the RGB data sets processing in 12 – 24 hours. While processing
times may be long, the scene reconstruction and orthomosaic generation is automatically
RGB
ortho

NIR
ortho

RGB
ortho

NIR
ortho

RGB
ortho

NIR
ortho

N
June 1, 2019

June 29,
July 27,
2019
2019
Figure 19: RGB and NIR orthomosaics generated from image sets acquired on three dates
showing the difference in coloration and brightness between the two cameras (Mavic Pro
RGB on June 1, 2019 and Phantom 4 Pro RGB on June 29 and July 27, 2019) and with the
same camera with different environmental conditions.
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performed by the structure-from-motion software, WebODM. Processing requires periodic
monitoring but is essentially labor free, but it is resource intensive and may require a dedicated
computer during processing.

Radiometric Calibration
Reflectance Spectra
The groups of reflectance spectra for each calibration panel obtained on June 15, 2019
at the OGSIR site are shown in Figures 20 - 22. The plots show vertical shifts between the
spectra in each group and it is important to note that the vertical axis is a different scale in each
of the figures. The temperature readings recorded between the acquisition of each group of
spectra are shown in Table 2. The temperature of the instrument increased between 0.4o F and
3.8o F during the acquisition of the groups of spectra. The temperature increased 2.0oF during
the acquisition of the spectra for the white calibration panel, 3.8oF during the acquisition of the
black panel spectra, and 0.4oF during the acquisition of the gray panel spectra.
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White Panel Reflectance Spectra (06/15/19)
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Figure 20: Reflectance spectra for the white calibration panel showing each measurement in
the order it was acquired.

Gray Panel Reflectance Spectra (06/15/19)
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Figure 21: Reflectance spectra for the gray calibration panel showing each measurement in
the order it was acquired.
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Black Panel Reflectance Spectra (06/15/19)
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Figure 22: Reflectance spectra for the black calibration panel showing each measurement in
the order it was acquired.
Table 2: Temperature Readings Recorded During Spectra Collection on June 15, 2019
Time

Temperature (oF)

11:11 am

78.4

11:14 am

80.4

Taken between white
and black panel spectra
collection

11:17 am

84.2

Taken between black
and gray panel spectra
collection

84.6

Taken after gray panel
spectra
collection.
Final temperature.

11:20 am

Picture

Description
Initial
temperature.
Taken prior to white
panel spectra collection
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The reflectance spectra plots show the spectral readings in the order they were taken.
The highest reflectance obtained for the white calibration panel occurred on the first, second,
fourth, and fifth spectral readings. The third, sixth, and eighth spectral readings are central,
with the seventh reading having the lowest overall reflectance. Similar patterns are present in
the reflectance spectra for the gray and black calibration panels. There is no consistent vertical
shift corresponding to increasing temperature in the thermal housing environment containing
the instrument. This indicates that these vertical shifts may be due to noise in the instrument or
directional differences in the reflectance of each panel.
Additionally, Table 3 gives 10 samples of the reflectance readings at a 0.37 nm
sampling interval for the white calibration panel showing standard deviation values for each
sampling interval. This sample of 10 readings demonstrates the method for obtaining the
standard deviation of all sampling intervals for each calibration panel. Table 4 gives the mean,
maximum, and minimum standard deviation values between reflectance readings over all
sampling intervals for each calibration panel. The mean standard deviation values between
reflectance spectra for each panel are low, with 3.0% reflectance, 1.2% reflectance, and 0.2%
reflectance of all sampling intervals between the eight spectral readings for the white, gray, and
black calibration panels, respectively. Figure 23 shows the mean reflectance curves for each
calibration panel.
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Table 3: A sample of white Panel Reflectance (%) Readings at 0.37 nm Sampling Interval and
σ (%)
λ (nm)

σ (%)

Reflectance Measurement
1

2

3

4

5

6

7

8

382.0

31.5

32.3

30.2

31.5

31.6

29.2

27.7

27.4

30.2

382.4

31.9

32.6

30.5

31.8

31.9

29.5

27.9

27.6

30.5

382.8

32.2

32.8

30.7

32.1

32.2

29.7

28.2

27.8

30.7

383.2

32.4

33.1

31.0

32.4

32.4

30.0

28.4

28.0

30.9

383.5

32.6

33.3

31.2

32.5

32.6

30.2

28.5

28.1

31.1

383.9

32.9

33.6

31.5

32.8

32.9

30.4

28.8

28.3

31.4

384.3

33.2

33.9

31.8

33.1

33.2

30.7

29.1

28.6

31.7

384.6

33.5

34.2

32.2

33.4

33.5

31.0

29.4

28.9

32.0

385.0

33.8

34.5

32.5

33.8

33.9

31.3

29.7

29.3

32.4

385.4

34.3

34.9

32.9

34.2

34.3

31.7

30.1

29.7

32.8

Table 4: Standard Deviation Values between Sample Readings for all Calibration Panels
White Panel

Gray Panel

Black Panel

Min σ (%)

1.8

0.8

0.1

Mean σ (%)

3.0

1.2

0.2

Max σ (%)

3.8

1.4

0.3
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Calibration Panel Mean Reflectance Curves
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Figure 23: Mean reflectance curves for the white, gray, and black calibration panels.

Image Digital Numbers (DNs)
The mean DN values for each calibration panel in the red and NIR spectral bands for
June 1, June 29, and July 27, 2019 data sets are given in Tables 5, 6, and 7. The mean DN value
is derived from close to 200 pixels in the interior of the calibration panels. The standard
deviation of the DN values ranges from 0.36 to 3.77, or 0% to 1.48% of the 8-bit DN value
range (0 – 255). Jeong et al. (2018) tested commercial calibration panels and found that the
standard deviation of DN values ranged from 0 – 12.66, or 0% to 4.96% of the 8-bit DN value
range. The DN values for these panels on all dates is well within this range. The low standard
deviation of calibration panel reflectance data and DN values in the two image bands confirms
that the panels exhibit Lambertian properties.
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Table 5: Mean Calibration Panel DN Values Extracted from the Imagery Sets
June 1, 2019
MAPIR NIR Band
Calibration Panel

DN Mean

DN Std Dev

Pixel Count

White

104.9

3.32

224

Gray

50.2

2.07

224

Black

9.6

Calibration Panel

DN Mean

DN Std Dev

Pixel Count

White

254.9

0.09

255

Gray

221.6

2.36

152

Black

53.9

5.38
June 29, 2019

238

1.01
Mavic Pro Red Band

224

MAPIR NIR Band
Calibration Panel

DN Mean

DN Std Dev

Pixel Count

White

107.6

2.24

182

Gray

46.2

1.77

196

Black

8.7

Calibration Panel

DN Mean

DN Std Dev

Pixel Count

White

247.1

0.36

202

Gray

237.2

0.99

196

Black

81.3

3.77
July 27, 2019

206

0.83
Phantom 4 Pro Red Band

169

MAPIR NIR Band
Calibration Panel

DN Mean

DN Std Dev

Pixel Count

White

45.8

1.45

196

Gray

21.3

1.04

210

Black

5.1

Calibration Panel

DN Mean

DN Std Dev

Pixel Count

White

254.9

0.33

85

Gray

234.9

0.68

169

Black

80.9

2.21

182

1.13
Phantom 4 Pro Red Band

196
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Empirical Line Method (ELM)
Table 6 gives the mean reflectance values corresponding to the spectral ranges
associated with the camera wavebands. Figure 24 shows the scatter plots and the two regression
models examined for converting image DNs in the red and NIR wavebands to reflectance for
the June 29, 2019 data set. The relationship between surface reflectance and image DNs is not
always linear, as shown by Wang and Myint (2015), but may be exponential instead.
Exponential equations prevent false calibration or using a surface reflectance greater than 100%
(Jeong et al., 2018). However, calibration was performed with three calibration targets, or three
data points. This does not provide enough data to reliably fit an exponential regression model
to the calibration data. Additionally, the coefficient of determination for the linear regression
models are 0.636 and 0.999 for the red and NIR bands, respectively. The coefficients of
determination for the exponential regression models is 0.688 and 0.749 for the red and NIR
bands, respectively. The linear equations provided the overall best fit for the Red and NIR
bands without overfitting the data.
Table 6: June 15, 2019 Mean Reflectance Data
White Calibration Panel (8 sample spectra)
Band

Spectral Range (nm)

Central Wavelength (nm)

Mean Reflectance

Red

580 - 670

625

84.6

NIR

850

850

101.8

Gray Calibration Panel (8 sample spectra)
Band

Spectral Range (nm)

Central Wavelength (nm)

Mean Reflectance

Red

580 - 670

625

31.5

NIR

850

850

37.5

Black Calibration Panel (7 sample spectra)
Band

Spectral Range (nm)

Central Wavelength (nm)

Mean Reflectance

Red

580 - 670

625

3.6

NIR

850

850

3.7

Red Band Linear Regression – June
29, 2019

NIR Band Linear Regression – June
29, 2019
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Figure 24: The relationship between calibration panel surface reflectance and image DN for
June 29, 2019 data showing both linear and exponential regression models.
Figure 25 shows the scatter plots and linear regression models for the three data sets in
the Red and NIR wavebands. The relationship between the image DNs and the surface
reflectance of the calibration panels is given in Equation 3:
𝑅𝑖 = 𝑏𝐷𝑁𝑖 + 𝑎

(3)

where Ri = the converted reflectance of band i pixels, a = conversion coefficient, b = calibration
parameter, and DNi = the DN values of band i (Jeong et al., 2018; Wang and Myint, 2015).
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Figure 25: The linear relationship between calibration panel surface reflectance and image
DN for the three flight dates, June 1, June 29, and July 27, 2019.
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The resulting calibration equations for the red and NIR wavebands of each data set are
given in Equations 4 – 9:
June 1, 2019
𝑅𝑅𝑒𝑑 = 0.3264𝐷𝑁𝑅𝑒𝑑 − 17.825

(4)

𝑅𝑁𝐼𝑅 = 1.0381𝐷𝑁𝑁𝐼𝑅 − 9.375

(5)

June 29, 2019
𝑅𝑅𝑒𝑑 = 0.3528𝐷𝑁𝑅𝑒𝑑 − 26.631

(6)

𝑅𝑁𝐼𝑅 = 0.9977𝐷𝑁𝑁𝐼𝑅 − 6.386

(7)

July 27, 2019
𝑅𝑅𝑒𝑑 = 0.3577𝐷𝑁𝑅𝑒𝑑 − 28.140

(8)

𝑅𝑁𝐼𝑅 = 2.4289𝐷𝑁𝑁𝐼𝑅 − 10.811

(9)

Each of these calibration equations has a negative y-intercept, or calibration parameter, which
means the minimum reflectance is zero in both red and NIR bands for each image set. These
calibration parameters are lower than those found in other studies calibrating UAS imagery to
ground reflectance using linear regression (Del Pozo et al., 2014; Iqbal et al., 2018). However,
some UAS sensors have been shown to over-estimate reflectance, such as the results from this
study for the Phantom 4 Pro, Mavic Pro, and to a lesser extent, the Survey3N sensors (Cao et
al., 2019). The minimum DN for each image set is given in Table 7. The pixel values below
this minimum DN value have pixel values of NoData and show as white areas in the band
images in Figure 26. When calculating band ratios using these two bands, the NoData cells are
treated as having zero as a value. This is most visible in the Red band data for all three dates,
where these locations have no reflected red light, or all red wavelength light is absorbed.
Table 7: The Minimum DN Value Defined by the Calibration Equations
June 1, 2019

June 29, 2019

July 27, 2019

Red Band

54.61

75.48

78.67

NIR Band

9.03

6.85

4.45
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Figure 26: Calibrated Red and NIR image bands with minimum reflectance of zero, shown as
white areas with pixel values of NoData.
To improve the accuracy of this method, a validation data set should be obtained during
data acquisition. One validation method is to include additional EVA foam panels of various
shades in UAS image sets and obtain surface reflectance measurements with the OceanOptics
Flame spectrometer. Another option is to obtain surface reflectance measurements of other
objects in the image sets, like vegetation or pavement. Predicted reflectance values for these
validation areas can be generated from the calibration equations and compared to the
reflectance measurements to validate the calibration equations.
This calibration method requires little time and effort. Acquiring the ground-truth data
for the three calibration panels in the field is easily completed in under an hour, while
processing the data and performing the ELM requires approximately two hours per data set.
The addition of a validation procedure will increase the time investment substantially, with
each additional sampled area requiring the same time and effort as one calibration panel for
data collection and processing. Obtaining a validation set of EVA foam panels is inexpensive
with EVA foam panels frequently sold in packages with many panels of various colors.

Normalized Difference Vegetation Index (NDVI)
The floating point NDVI data for the three dates is shown in Figure 27, where the high
NDVI values are displayed as white and the low values as black. Visually, the June 1, 2019
NDVI image shows more high values than the June 29 and July 27, 2019 NDV images. Figure

43
28 gives the histograms of the NDVI data for each bioretention cell and for each date showing
the frequency of pixels having each class of NDVI value. The bin width is 0.2 to create 10
classes in the NDVI range of -1 to 1. On June 1, 2019, the highest frequency in all cells occurs
in the NDVI range of 0.8 – 1.0, indicating a high frequency of pixels containing healthy
vegetation. On June 29 and July 27, 2019, the highest frequency in Cell 1 is in the NDVI range
of -0.2 – 0.0, indicating dead vegetation and bare soil. However, in Cells 2 and 3 on all dates,
the highest frequency of NDVI values remains in the range of 0.8 – 1.0, with Cell 3 having a
higher frequency in this range than Cell 2 on both dates. This indicates that Cell 3 maintains
more pixels representing healthy vegetation than Cell 2 during the transition from Spring into
Summer. During this period, the water source changes from runoff from the catchment
supplemented with rainfall to primarily drip irrigation.

N

June 1, 2019

June 29,
2019

July 27, 2019

Figure 27: NDVI data shown in floating point format for June 1, June 29, and July 27, 2019.
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Figure 28: NDVI Histograms for June 1, June 29, and July 27, 2019 showing the frequency of
pixels with each class of NDVI data for Cells 1, 2, and 3.
Figure 29 shows classified NDVI maps of the OGSIR bioretention facility for the 3
dates with the same 10 classes as those shown in the histograms, where there are 5 classes from
-1 to 0 and 5 from 0 to 1. The spatial distribution of each class is shown in the figure. The
shades of green represent healthy vegetation, yellow represents senescent or fading vegetation,
orange and brown represent soil and dead vegetation, and red represents no vegetation. The
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values close to -1 are in the gravel/rock on the side of the rain garden. Cell 1 contains only
weeds, showing the effect they have on the NDVI in all cells in the data sets. Once these weeds
die, the remaining green areas in Cells 2 and 3 represent the original vegetation planted in the
facility in 2014. The largest concentration of green values, or healthy vegetation on June 29
and July 27 is close to the inlet on the south end of the facility, with the coverage of green
values decreasing at 1/3 of the length of the facility and continuing to decrease moving away
from the inlet.
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Figure 29: Classified NDVI data for the three dates showing the spatial distribution of NDVI
values.

Spatial Analysis
Figure 30 shows the NDVI change in relation to the distance from the inlet. The drop
in the NDVI values for the entire area of Cell 1 represents the change in weed coverage as
water availability and the temperature changes during the month of June. The June 1 data set
for all cells contains a large amount of weed coverage. Once the spring weeds died in Cell 2,
the coverage of high NDVI values starts a downward trend immediately moving away from
the inlet. NDVI values in Cell 2 stayed between 0.45 and 0.75 within 40 feet from the Cell 2
inlet, with values falling to below 0.3 at 50 ft from the inlet. NDVI values stayed between 0.5
and 0.8 within 30 feet from the Cell 3 inlet, with values falling below 0.3 at 60 feet from the
inlet. The broad leaf vegetation has high NDVI values down the length of Cell 3, likely causing
the increase in NDVI in the final 35 feet of the cell.
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Figure 30: NDVI related to distance from the inlet for Cells 1, 2, and 3.
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Eight of the 41 AOIs were at sedge locations. The mean NDVI of these eight sedges is
0.82, 0.78, and 0.82 on June 1, June 29, and July 27, respectively. Sedge species common in
natural stands of sedge found in wet sedge tundra ecosystems were shown to have NDVI values
of 0.55 (Boelman et al, 2003). Figure 31 gives the floating point NDVI image for July 27, 2019
with the eight sampled AOIs. The NDVI of water sedge common in northern wetlands in
Literature is 0.68 (Goswami et al., 2015). Boelman et al. (2003) considered NDVI values of
0.5 to represent sparse vegetation and values reaching 0.7 represent dense vegetation. The
NDVI of the slough and dense sedge growing in the OGSIR facility are much higher than those
found in tundra wetlands, which is to be expected when comparing engineered vegetated
systems to natural stands in different climate regions. The differences in NDVI between sedge
species in the OGSIR facility and sedge species in natural wetlands is likely due to differences
in soil media and access to water and should be studied further in future research.

N

Figure 31: NDVI image with AOIs circling sedge species in the OGSIR facility.
These studies explored the relationship between NDVI and biomass, both finding a
strong relationship between the two parameters, similar to the early research of Rouse et al.
(1974) and the recent research of Doughty and Cavanaugh (2019) showing the correlation
between NDVI and above-ground biomass and the application of biomass based wetland
mapping using NDVI. Considering this relationship, the high NDVI values indicate dense
vegetation and a correspondingly high biomass in the OGSIR facility, especially close to the
inlet. Changes in NDVI-based biomass estimates over time can indicate the presence of
stressors and spatial variations in these estimates can indicate stress in vegetation caused by
spatial variables.

Temporal Trend Analysis
There is a visible change in healthy vegetation coverage from the beginning of June
through the end of July. This is most evident in the month of June, where the bulk of the area
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in the facility is covered by high NDVI values due to the grassy weeds filling all of Cell 1, and
filling the gaps in vegetation in Cells 2 and 3. This is shown in Figure 29. The grassy weeds
die off, leaving dry brown vegetation later in June and July. Figure 32 shows this change in
coverage area for NDVI values representing healthy vegetation (0.6 – 1.0), NDVI values
representing unhealthy or stressed vegetation (0.2 – 0.6), NDVI values representing soil and
dead vegetation (-0.2 – 0.2), and NDVI values representing a complete absence of vegetation
(-1.0 - -0.2). NDVI values ranging from 0.6 to 1.0 in Cell 2 covered 650 ft2 of the facility in
early June and fell by over 56% by the end of June, with a corresponding increase in area
covered by NDVI values close to zero and below zero during June. NDVI values ranging from
0.6 to 1.0 in Cell 3 covered close to 800 ft2 in early June and declined by 52% during June, also
with a corresponding increase in the area covered by NDVI values close to zero and below
zero.
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Change in NDVI over Time - Cell 1
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Figure 32: Temporal plots of NDVI showing change over a two-month period in each of the
three bioretention cells.
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Method Evaluation
The NDVI data generated from the calibrated UAS image sets proved useful in
detecting changes in the area covered by vegetation classes over time, and in exploring the
spatial distribution of NDVI values. However, this method is not without errors. First, NDVI
generated from different sensors cannot be directly compared without examining the spectral
regions and band peaks included in the band pass filters of each CMOS sensor (Miura et al.,
2006). The CMOS sensors in the Mavic Pro and Phantom 4 Pro likely have differing spectral
ranges in the red spectral response curve and differing red peaks. Unless the differences are
minor, they will affect the resulting NDVI values. It is important to be aware that many
manufacturers, including DJI, do not make the spectral response curves available to the public.
This should be considered during the planning process to inform the selection of equipment.
Zhang et al. found that shadows cause an over-estimate of NDVI, but when computing
vegetation parameters from NDVI, like vegetation fractional coverage (VFC), the results were
not strongly affected by the presence of shadows (2015). As shown in Figure 33, a side-by-side

Figure 33: June 29, 2019 RGB (left) and classified NDVI (right) maps showing the high
NDVI values associated with the presence of shadows
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comparison of the June 29 RGB orthomosaic and the June 29 classified NDVI map, part of the
area covered by the highest NDVI values is shaded. Some of the areas circled in Figure 33 may
correspond to healthy vegetation cast in shadows, while some represent shadows cast by
obstructions in the facility in areas of dry or dead vegetation. However, these areas have very
high NDVI values, indicating an over-estimate of NDVI.
There are many methods for detecting shadows in imagery, but histogram thresholding
is the simplest method and assumes that shadow and sunlit areas have different histogram levels
(Adeline et al., 2013). Increased accuracy can be reached by applying a shadow-detection
methodology to the image bands prior to generating the NDVI data. However, UAS flights
should be planned to reduce the presence of shadows by performing flights close to noon and
considering the effect of seasonality on shadow size. Even without removing shaded areas from
the analysis, this method allows for tracking changes in facility vegetation once a baseline of
health is established. Deviations from this baseline should trigger a maintenance plan of action.
This is a promising method allowing for long-term periodic monitoring of facilities.
With access to image analysis software, like ESRI ArcMap, the NDVI is easy to compute and
analysis provides useful information on the health of vegetation in GI. The method can be
improved using higher quality sensors designed for NDVI generation and using shadow
detection methods. Consistently using the same sensors for each flight ensures that resulting
NDVI data will be comparable across a temporal data set, eliminating the need to generate
cross-sensor models to translate reflectance from one sensor to match reflectance from another
(Miura et al., 2006). Using a sensor that has both red and NIR bands also reduces the need for
radiometric calibration using the ELM. However, the NDVI results obtained from inexpensive
sensors, calibration methodology, and NDVI classification performed in this study provides a
good idea of vegetation health with the potential for long-term monitoring to inform
maintenance decisions.

Regression analysis
Figure 34 shows the scatter plots and regression models to determine the NDVI
relationship to fIPAR in the bioretention cells. The Cell 2 relationship is very weak with a
coefficient of determination of 0.13. The Cell 3 relationship is stronger with a coefficient of
determination of 0.49. Figure 35 shows the scatter plots and regression models on the data
subset into sedge, rush, and broad leaf vegetation groups. It appears that the broad leaf and
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sedge NDVI-fIPAR relationship is stronger with coefficients of determination of 0.64 and 0.55,
with a very weak relationship for the rush group (R2 = 0.12). The vegetation groups have small
sample sizes and there is a potential for outliers to affect the regression model. One point in the
broad leaf scatter plot falls away from the main cloud of points and has a strong effect on the
regression model. Figure 36 shows the broad leaf regression model with this potential
regression outlier removed from the scatter plot. The relationship weakens (R2 = 0.19) without
this data point. With additional samples of each vegetation group, the relationship can be
determined more accurately.
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Figure 34: Scatter plots and regression models of the NDVI relationship to fIPAR in Cells 2
and 3 of the OGSIR bioretention facility.
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fIPAR vs NDVI - Broad Leaf
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Figure 35: Scatter plots and regression models of the NDVI relationship to fIPAR of the broad
leaf, sedge, and rush vegetation groups including vegetation from both cells of the OGSIR
bioretention facility.

54
fIPAR vs NDVI - Broad Leaf with outlier removed
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Figure 36: Scatter plot and regression model of the NDVI relationship to fIPAR of the broad
leaf vegetation group in both cells of the OGSIR facility with the potential outlier removed.
Studies show a strong relationship between radiometer derived NDVI and groundbased measurements of fIPAR in wheat crops during the growth phase with coefficients of
determination of 0.81 and 0.97 (Hatfield et al, 1984; Serrano et al, 2000). Strong relationships
were also found between UAV derived NDVI and ground-based measurements of fIPAR in
peach and citrus orchards with coefficients of determination of 0.88 and 0.85, respectively
(Guillen-Climent et al., 2012). However, these relationships were found for agricultural study
sites with the relationship examined for a single crop, while the bioretention facility has mixed
vegetation with varying canopy types and a unique set of challenges. Much as these challenges
influenced the fIPAR results, they also influence the exploration of a relationship between
fIPAR and NDVI. As a result, the potential for bias in the fIPAR results is carried into the
regression analysis.
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Conclusions and Recommendations
Monitoring GI vegetation allows for the early detection of various causes of vegetation
stress, including contaminant induced stress, water stress, and disease. Without detection,
vegetation stress can lead to reduced performance of GI facilities, impacting facility filtration
capability, contaminant uptake rates, hydrologic attenuation, soil stability and microbial
communities, and evapotranspiration rates that control the cooling effect of larger facilities.
Effective GI monitoring methods inform management and maintenance decision making. Two
methods were examined for use in GI facilities at the OGSIR bioretention facility, remotely
acquired NDVI for monitoring reflectance-based indicators of vegetation stress and groundbased fIPAR measurements to indicate vegetation density and biomass production.
fIPAR was measured using a hand-held ceptometer, the Accupar LP-80, at 41 sample
points in Cells 2 and 3 of the OGSIR bioretention facility. Spatially, there was very little change
as the distance between the sample points and the inlet increased. While fIPAR values are
generally higher closer to the inlet and moderate to low farther from the inlet, values were not
consistently high for vegetation that appears healthy or low for vegetation that appears
unhealthy. Small sample groups of sedges and rushes had high fIPAR values when compared
to fIPAR values of natural stands. However, various challenges caused potentially biased
results. The geometry and location of obstructions in the facility led to some sample
measurements being over or under-estimated. The clumping nature of sedge and rush species,
as well as the difficulty in accessing sample points in densely planted areas of the facility
caused the canopy to be disturbed prior to measurements, leading to inaccurate results. Groundbased methods, like this one, that require sampling individual plants, entering densely
vegetated areas, and avoiding many obstacles are laborious and time consuming with a high
potential for error. Direct measurement of fIPAR is not a feasible method for long-term
monitoring of GI facilities.
UAS data sets were acquired with two drones, the DJI Mavic Pro and the DJI Phantom
4 Pro, and the MAPIR Survey3N NIR camera, mounted externally. Data sets were processed
with open-source software, WebOpenDroneMap, at a 1 cm/pixel resolution resulting in high
quality, low-distortion orthomosaics. The orthomosaics were calibrated to ground-based
reflectance measurements to reduce any inaccuracies caused by the sensors and to ensure that
the multiple sensors represent the actual reflectance. This is especially important when
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comparing and combining data from multiple sensors and when comparing data from multiple
dates. Calibration was performed with the reflectance data of three EVA foam panels (white,
gray, and black) obtained with an OceanOptics Flame spectrometer, DN values of the EVA
foam panels from each orthomosaic and using the empirical line method. Linear regression
equations were derived for the red and NIR bands of the three data sets with the red band having
coefficients of determination ranging from 0.636 to 0.731 and the NIR band having higher
coefficients of determination ranging from 0.992 to 0.999. A more accurate calibration
procedure requires additional calibration panels, including more levels of gray, to improve the
regression models. A validation procedure should be included in future research to verify the
accuracy of the calibration equations.
NDVI maps were generated from the calibrated Red and NIR bands of the
orthomosaics using ESRI ArcMap. Three NDVI maps were examined for spatial distribution
and temporal changes in NDVI values. Cell 1 contains only weeds during the study time period,
while Cells 2 and 3 contain vegetation originally planted in the facility and seasonal weeds.
High NDVI values dominate all three cells on the early June NDVI map, representing the
abundance of healthy weeds at the end of spring. At the end of June and July the seasonal weeds
have died and the high NDVI values correspond to the healthy vegetation originally planted in
the facility.
Spatially, mean NDVI values in Cells 2 and 3 are highest in the first 30 to 40 feet
measured down the length of the facility from the inlet, or the third of the facility closest to the
inlet. Cell 3 maintains higher NDVI values in this area of the facility than Cell 2, indicating
that mixed vegetation remains healthier when close to the primary water source than when
vegetation is limited to the sedges, rushes, and grasses of Cell 2. Most of the mean NDVI values
in Cell 3 in the 30 feet closest to the inlet are above 0.6, representing very healthy vegetation
in this region. This indicates that the vegetation is not heavily influenced by contaminants in
the facility runoff after the vegetative growth that occurs at the end of the rainy season.
However, NDVI values should be generated with a consistent set of sensors or a sensor having
both the red and NIR bands to ensure that NDVI values are directly comparable.
NDVI values in the bioretention cells are influenced by the presence of shadows, with
some regions showing very high NDVI values being deeply shaded. Temporally, the amount
of area with high NDVI values representing healthy vegetation drop through the month of June
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as the seasonal weeds die while the amount of area with NDVI values close to zero representing
soil and dead vegetation increase. When monitoring NDVI over time, knowledge of the facility
growth patterns increases the ability to establish a baseline of vegetation health. Deviations in
the baseline can trigger site visits, further data acquisition, maintenance and analysis of
potential causes of the deviation.
Special consideration should be given to flight planning to reduce the effect of shadows
on NDVI values. With flights planned for the same time of day using the same flight path for
individual facilities, then the effect of shadows becomes dependent on seasonal changes in the
sun angle. Future research of NDVI methods for monitoring GI facilities needs to examine
long-term monitoring and the effect of seasonal changes in the angle of sunlight on skewing
NDVI values. With the inclusion of shadow detection during one year of seasons, research
should examine the potential of establishing seasonal baselines for GI facilities. Seasonal
NDVI baselines will allow for changes in NDVI to not only trigger maintenance decisions but
will also allow changes to be further analyzed to determine underlying causes. Overall, NDVI
maps can prove valuable for long-term monitoring of GI vegetation, especially in large GI
facilities.
There was no strong relationship between the fIPAR and NDVI results. The unreliable
results obtained from the fIPAR methods likely influenced the exploration of a relationship
between the two parameters. However, the bioretention facility is inherently different from the
agricultural study sites investigated in previous literature, with an irregular planting
arrangement, mixed species in the canopy make-up, and unregulated growth and health.
Agricultural sites generally have regular rows of a single crop maintained for consistent growth
and health. The structure of agricultural sites promotes consistency in data collection methods
with fairly controlled conditions. Overall, errors in the fIPAR results are carried into the
analysis of the relationship between fIPAR and NDVI. A lack of a relationship between NDVI
and fIPAR precludes the use of NDVI results as a proxy for fIPAR in biomass productivity
models. However, NDVI derived from calibrated imagery is a valuable reflectance-based
vegetation health parameter useful as a stand-alone indicator of stress in vegetation.
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Appendix A: 2018 Plant Identification and Assessment
Table 1: 2018 Visual Inspection - Vegetation Identification and Assessment Data

Date

Species

Cell

5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018

saxifraga oregana
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
mahonia repens
achillea millefolium

3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3

xcoord
(ft)
5.3
10.1
10.4
10.2
0.5
1.9
0.8
1.8
2.3
0.8
8.9
10.3
8.8
10.3
9.9
0.6
8.7
1.1
1.3
0.0
2.9

ycoord
(ft)
37.4
2.7
2.0
9.2
7.8
6.9
31.1
33.1
38.3
49.8
54.6
54.8
62.6
62.0
70.8
70.8
78.6
80.6
81.3
89.8
92.3

Status
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
small-not as healthy
small
small
Healthy
healthy
healthy
small-unhealthy
healthy
healthy
small but healthy
small
Healthy
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5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/5/2018
5/26/2018
5/26/2018

achillea millefolium
achillea millefolium
achillea millefolium
achillea millefolium
achillea millefolium
achillea millefolium
camassia quamash
camassia quamash
camassia quamash
camassia quamash
sildacea campestris
symphocarpos albus
symphocarpos albus
symphocarpos albus
symphocarpos albus
symphocarpos albus
symphocarpos albus
symphocarpos albus
symphocarpos albus
symphocarpos albus
symphocarpos albus
rosa nutkana
rosa nutkana
lupinus polyphyllus
lupinus polyphyllus
lupinus polyphyllus
lupinus polyphyllus
lupinus polyphyllus
juncus patens
juncus patens

3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3

9.9
10.3
10.3
10.0
10.1
8.5
10.3
0.5
2.4
8.3
4.2
9.9
1.5
10.4
1.3
10.4
1.3
10.4
1.3
10.4
1.3
10.4
10.4
4.5
6.2
6.9
4.0
7.7
7.4
5.6

89.3
21.3
20.6
11.0
81.3
80.7
13.4
19.2
8.0
1.8
16.0
15.0
23.6
19.0
5.0
35.0
44.5
57.0
66.0
77.0
85.0
85.0
46.0
80.0
83.0
46.0
40.0
39.0
80.8
86.3

Healthy
small but healthy
small healthy
small healthy
small healthy
healthy
seeded-small
seeded-small
flowering-healthy
flowering-leaves less healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
orange spots on leaves and buds
Healthy
small, but healthy
small, but healthy
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5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/5/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/5/2018

juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
grass species - deschampsia?
grass species - deschampsia?
grass species - deschampsia?
scirpus acutus
scirpus acutus
scirpus acutus
scirpus acutus
gaulthera shallon
dark green rush (off list)
dark green rush (off list)
dark green rush (off list)
dark green rush (off list)
carex densa

3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3

3.9
5.4
6.5
7.0
3.3
3.2
4.8
5.8
7.1
6.0
7.1
10.3
9.8
0.8
7.4
4.0
6.0
5.8
6.0
9.5
8.5
3.0
1.5
1.0

5/5/2018

carex densa

3

7.5

5/5/2018
5/26/2018
5/26/2018
5/26/2018

carex densa
sedge (carex densa?)
sedge clumps (carex densa?)
sedge (carex densa?)

3
3
3
3

8.6
3.0
6.5
6.8

80.4
58.9
50.9
48.1
43.3
39.7
26.3
22.9
18.3
16.2
12.6
20.8
10.1
59.0
2.0
6.0
15.5
21.0
8.1
19.5
27.5
31.0
56.5
13.0
2030
82.0
89.0
85.5
82.0

very small
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
mostly healthy-some dead at base
mostly healthy-brown spotted leaves
short (not watered, maybe)
not healthy (crowded)
not healthy
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5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
5/26/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018

sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
sedge (carex densa?)
grass with compact yellow flowers
grass with compact yellow flowers
grass with compact yellow flowers
grass with compact yellow flowers
grass with compact yellow flowers
grass with compact yellow flowers
grass with compact yellow flowers
grass with purple flowers and soft blue green leaves

3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3

5.0
6.0
7.7
6.5
6.0
6.0
3.0
7.0
7.5
7.0
8.0
3.5
5.0
4.0
6.0
3.0
3.5
6.0
3.5
7.0
6.0
7.0
1.1
4.0
3.3
4.1
3.1
9.3
2.5
1.1

80.5
77.0
74.5
71.0
68.0
64.5
55.0
52.5
41.0
44.0
40.5
38.0
35.0
34.0
23.0
21.0
12.0
9.0
8.0
7.0
6.0
4.0
6.8
31.0
26.5
33.0
34.0
82.0
33.8
33.0

healthy
not healthy
Healthy
not very healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
some dying
healthy
healthy
healthy
healthy
healthy
some dying
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
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6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018

grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
grass with purple flowers and soft blue green leaves
scirpus acutus
scirpus acutus
scirpus acutus
scirpus acutus
scirpus acutus
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens

3
3
3
3
3
3
3
3
3
3
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2

1.2
4.9
5.1
4.4
3.8
8.9
0.1
0.1
3.0
1.8
0.8
9.0
7.8
2.9
0.5
6.8
5.8
5.7
5.7
4.6
3.9
5.3
5.0
5.1
4.0
5.2
5.2
3.8
6.4
5.6

5.3
5.0
5.7
6.0
37.0
37.0
40.0
52.4
57.0
57.0
14.8
1.5
19.0
31.5
26.8
5.7
4.3
6.5
8.7
9.5
11.5
12.4
14.6
16.0
17.7
19.0
20.0
20.5
21.6
22.0

Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
Healthy
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6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018

juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens

2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2

5.8
5.8
6.0
4.6
6.8
4.6
5.3
5.3
6.4
5.0
5.1
6.4
5.3
5.2
3.8
3.7
5.4
3.5
5.0
5.8
3.7
3.5
6.7
4.9
5.4
6.7
5.7
6.2
5.6
3.8

22.4
23.7
23.2
24.4
25.6
25.5
26.4
27.6
27.8
27.3
28.4
30.1
30.6
31.7
32.7
33.1
34.5
35.6
35.8
36.5
36.9
38.0
41.0
43.0
43.6
43.2
44.7
46.0
47.6
48.2

Healthy
healthy, small
healthy
healthy,small
healthy
kind of brown
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
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6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018

juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens
juncus patens

2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2

4.0
6.5
3.0
8.0
6.0
5.5
4.0
4.4
5.5
4.4
4.4
4.4
5.0
4.0
4.0
4.5
4.5
6.5
6.0
7.0
4.0
6.0
4.5
6.0
5.0
7.0
5.0
5.0
6.0
4.3

49.5
49.1
88.5
86.5
83.5
82.0
81.0
78.0
77.0
76.0
75.0
74.0
72.0
70.5
69.5
65.0
64.5
62.5
62.0
60.5
59.5
58.0
55.5
55.0
53.0
52.0
51.0
67.5
66.0
41.0

healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
semi-healthy
semi-healthy
unhealthy
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6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018

juncus patens
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)

2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2

4.5
8.0
3.0
3.0
8.0
3.4
3.5
7.5
7.5
3.3
3.0
3.0
8.0
7.5
7.5
3.0
6.0
3.0
4.4
9.0
3.3
7.5
3.4
3.0
8.0
8.0
3.0
7.5
7.5
3.5

56.5
56.0
58.5
59.0
69.0
18.0
24.0
22.0
25.5
27.3
51.0
73.0
37.2
84.0
31.0
61.0
67.0
69.0
46.0
61.0
4.5
11.5
12.0
64.0
70.0
74.0
45.0
81.0
82.0
84.0

not healthy
dead
dead
dead
dead
dead
all dead
dead
dead
dead
dead
dead
dead
dead
dead
almost dead
almost dead
almost dead
almost dead
not very healthy
not healthy
not healthy
not healthy, some dry
not healthy
semi-healthy
semi-healthy
semi-healthy
semi-healthy
semi-healthy
semi-healthy
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6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018
6/2/2018

sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)

2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2
2

3.3
3.5
3.0
3.0
3.0
8.0
7.5
7.5
3.0
7.0
78.0
3.4
3.4
8.0
3.4
8.0
3.3
3.0
7.5
8.0
3.4
8.0
7.3
3.0
8.0
7.5
3.0
7.5
8.0
8.0

29.0
78.0
34.0
42.0
76.0
77.0
78.0
90.0
2.2
2.2
5.0
5.5
6.5
6.5
8.5
8.5
9.5
67.0
10.5
64.0
11.0
12.0
27.3
32.0
33.0
39.5
43.5
44.0
45.0
47.0

semi-healthy
semi-healthy
semi-healthy
semi-healthy
semi-healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy
healthy and some dry
healthy
healthy
some dry parts
healthy
healthy
healthy
healthy
healthy
healthy
healty
healthy
~ 80% healthy
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6/2/2018
6/2/2018
6/2/2018

sedge clumps (carex densa?)
sedge clumps (carex densa?)
sedge clumps (carex densa?)
2014 Approximate Plant Count obtained from Cost
Estimate
2017 UAV Image Approximate Plant Count
2018 Ground Survey Plant Count

2
2
2
855
156
263

8.0
3.0
8.0

50.0
53.0
54.5

healthy
healthy
healthy
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Figure 1: 2018 Cell 3 vegetation species identification and location.

Figure 2: 2018 Cell 2 vegetation species identification and location.
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Figure 3: Summer 2017 UAV orthomosaic obtained with Mavic Pro, partial data set used to estimate the location and
number of plants present in OGSIR facility. Orthomosaic with labeled plant count (bottom) performed direction on
orthomosaic from visual inspection of ortho.
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Figure 4: Orthomosaic generated from 2014 UAS imagery timed shortly after vegetation was originally planted. Labeled
plant locations (bottom) were generated using 2017 Mavic Pro imagery, overlaid on the 2014 orthomosaic to provide a
sense of the difference in density of vegetation between 2014 and 2017.
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Appendix B: Standard Operating Procedures
B.1 fIPAR Data Acquisition, Formatting, and Spatial Analysis
The fraction of photosynthetically active radiation (fIPAR) is the amount of sunlight
intercepted by the plant canopy.
List of Instruments & Software:
1) Meter Group Accupar LP-80 Ceptometer.
2) Basic camera tripod with removable base plate
3) Gloves and protective sleeves
4) GNSS equipment – antenna, antenna pole, and controller
5) Rubbing alcohol and microfiber cleaning cloth
6) Accupar LP-80 Utility Software, downloadable at
https://www.metergroup.com/environment/products/accupar-lp-80-leaf-area-index/
7) Microsoft Excel
8) ESRI ArcMap
Procedure Summary:
1) Calibrate Accupar
2) Set up GNSS
3) Set up Accupar and external sensor
4) Acquire coordinates for center of area of interest (AOI) with data collector
5) Acquire four PAR measurements for each AOI with Accupar
6) Download data from instruments (spreadsheet from Accupar and txt file from GNSS)
7) Average Accupar measurements for each AOI
8) Compile averaged Accupar data and GNSS coordinate data
9) Add fIPAR data to new map document in ArcMap
10) Classify fIPAR data and display with appropriate symbology
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fIPAR data is acquired by using two connected sensors, a wand and an external sensor.
The wand (probe) contains 80 sensors, spaced 1 cm apart down the length of the 84 cm
wand and has a 1 cm resolution. The data from the probe includes PAR readings for 8
segments of sensors down the 32-inch length of wand, assumed to be spaced evenly down
the probe, with segment 1 closest to the controller and segment 8 farthest from the
controller. Segments can be turned on and off in the Accupar controller. We want all 8
segments active in the Active Segments screen in the Menu.
Detailed Procedure:
1) Calibrate Accupar
a. Attach the external sensor to the external sensor lug next to the bubble level at the
base of the Accupar wand using the bolt attached to the external sensor.
b. Plug the external sensor into the RS-232/external sensor port.
c. Power on the Accupar and press Menu to scroll to the final menu, “Config”
d. Scroll down to the first option, “Calibration” and press enter.
e. Hold the Accupar level under full sun (with PAR above 600 μmol m-1 s-1) and
press enter again to calibrate the instrument. Press enter a final time to accept the
calibration.
2) Set up Accupar sensors
a. Settings from previous data acquisition: The date, time, and location in the
Accupar are set to Corvallis and the present date from previous use at the OGSIR
facility. The leaf distribution parameter, χ, found in the Config menu, is the leaf
angle distribution in the canopy It is lower for plants with vertical leaves (0.7 for
onion), and higher for plants with horizontal leaves (3 for strawberries). The
default value is 1.0, a value appropriate for the mixed vegetation of the OGSIR
facility while being low enough for the vertical nature of sedges and rushes.

83
b.

Attach external sensor to base plate of tripod with bolt attached to the external
sensor. Extend the tripod fully ensuring that the external sensor is not shaded by
the operator or nearby buildings and trees but instead has full sky exposure.

c. Connect the external sensor to the RS-232 port on the Accupar controller and
adjust placement of the tripod to comfortably reach the AOI to be sampled. When
external sensor is connected, two PAR readings show on the display when the
PAR menu is open. Level the tripod.
3) Set up GNSS and acquire coordinates according to the Oregon State University School
of Civil and Construction Engineering “Real-Time Observations ORGN Leica GS14
GNSS” Student Instructions. Acquire coordinates at the center of each AOI.
4) Acquire PAR measurements
a. With the GNSS antenna pole still in place in the center of the AOI, place the
Accupar wand below the plant canopy and center it in the AOI. Place the Accupar
wand oriented N-S, E-W, NW-SE, or NE-SW. The Accupar sensor wand is
marked at 16 inches, or half of the distance down the wand. Align this mark with
the center of the GNSS antenna.
b. Level the wand and press the Up or Down arrow on the Accupar controller. This
records the above and below canopy PAR readings. Be sure to check your position
so that you do not shade the wand before recording each PAR reading.
c. Press enter to open the save screen on the controller.
d. Scroll to the Annotate option and press Enter
e. Enter a label for the AOI and press Enter again to save the readings.
f. Orient the wand in one of the other three directions, level it and press the Up or
Down arrow on the Accupar controller. Scroll up to Save and press enter. Repeat
for the remaining 2 PAR readings for the AOI.
g. Wipe any debris from the wand between measurements.
h. Repeat a – f for the remaining AOIs, moving and re-leveling the external sensor
tripod as needed.
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5) Download data from instruments
a. Obtain GNSS data from data controller using a flash drive and following “RealTime Observations ORGN Leica GS14 GNSS” Student Instructions for
downloading data.
b. Download and install the Accupar LP-80 Utility Software.
c. Connect the RS-232 cable to the instrument, connecting to the USB adapter cable
and plugging into the computer.
d. Open the LP-80 Utility Software, select the computer communications port, if not
already selected. Click on Download and save the spreadsheet.
6) Format and compile data
a.

Open the spreadsheet of Accupar data and save a new copy to edit.

b. The Summary Data sheet has the groups of annotated measurements, where the
first measurement in the group of four has an annotation.
c. The “Average Above PAR” values were acquired with the external sensor. The
“Average Below PAR” values are the average of the PAR readings acquired with
the 8 sensors in the wand. Create new columns next to the “Average Above PAR”
and “Average Below PAR” columns. In one column, average the four readings
from the “Average Above PAR” column for each annotated AOI. In the other
column, average the four readings from the “Average Below PAR column for each
annotated AOI.
d. Copy the new columns, “4 Direction Average Above PAR” and “4 Direction
Average Below PAR”, in this case to a new sheet.
e. Select blank rows (Find and Select > Go to special > blanks) and remove them
(Delete > Delete Cells).
f. In a new column, calculate the fIPAR value from the averaged above and below
PAR measurements as 𝑓𝐼𝑃𝐴𝑅 = 1 − 𝑃𝐴𝑅𝐵𝑒𝑙𝑜𝑤 /𝑃𝐴𝑅𝐴𝑏𝑜𝑣𝑒 .
g. Open the GNSS text file in excel (tab delimited).
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h. Copy the Easting and Northing columns and paste into the Accupar sheet, ensuring
that the GNSS point IDs are aligned with the corresponding Accupar annotations,
pairing the two data sets.
7) Add fIPAR data to new map document in ArcMap
a. Open ESRI ArcMap and create a blank map
b. Add the Accupar data with coordinates. File > Add Data > Add XY Data
c. Browse to choose a table and select the excel file with the fIPAR data and
coordinates and select the new sheet with the calculated fIPAR values and
coordinates.
d. Assign the Easting column to the X Field, Northing to the Y Field, and fIPAR to
the Z Field. Edit coordinate system and assign NAD 1983 StatePlane Oregon FIPS
(Intl Feet) (This can be entered in the search bar). Press OK to add the data. If a
warning stating that the table does not have an Object ID opens, just press OK.
Save the map.
8) Classify fIPAR data and display with appropriate symbology
a. Open layer properties and go to the Symbology tab.
b. Under Quantities, select Graduated Colors. In the Fields Box, select the fIPAR as
the Value. Choose a color ramp (brown through yellow to green is the previously
used one) and leave the classification at the default, Natural Breaks (Jenks). To
change the size or shape of the symbols, select all ranges and lables, right click and
select “Properties for selected symbols” (Previously used size was 10).
c. Save the classified map to later be combined with UAS orthomosaics and NDVI
data.
References
AccuPAR PAR/LAI Ceptometer Model LP-80: Operator's Manual. Meter Group, Inc.
https://www.metergroup.com/environment/products/accupar-lp-80-leaf-area-index/
Accupar LP-80 Utility Software. Meter Group, Inc.
https://www.metergroup.com/environment/products/accupar-lp-80-leaf-area-index/
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Real-Time Observations ORGN Leica GS14 GNSS Student Instructions. Oregon State
University School of Civil and Construction Engineering.
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B.2 UAS Image Acquisition and Processing
List of Instruments & Software:
1) Mavic Pro or Phantom 4 Pro drone, controller, SD card, and charged battery pack
2) MAPIR Survey3N NIR camera with charged battery, and SD card
3) MAPIR camera mount for selected drone
4) MAPIR Camera Control (MCC) software available at
https://www.mapir.camera/products/mapir-camera-control
5) WebOpenDroneMap (WebODM)
Procedure Summary:
1) Consult certified drone pilot to perform flights
2) Download imagery data from drone and external camera
3) Sort imagery
4) Pre-process NIR imagery
5) Process RGB and NIR imagery to obtain orthomosaics
Detailed Procedure:
1) Plan and perform flights with certified drone pilot
a. Consult drone pilot to select a flight elevation of 70 ft, speed of 4 mph, overlap of
95%, in a lawnmower pattern.
b. Check NIR camera settings to use 1/500 s and ISO 400.
c. Attach NIR camera to drone using appropriate camera mount
d. Perform several flights to have backup data sets for processing
2) Download imagery data from drone and external camera
a. Remove SD cards from drone and NIR camera and download imagery to PC,
placing NIR imagery in one directory and RGB imagery in another.
3) Sort imagery
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a. Visually examine image sets, looking for images close to the ground to identify the
imagery from each flight.
b. Copy the images for each flight into designated folders.
c. There should be an RGB set and a NIR set of images for each flight. This creates
pairs of imagery for each flight.
d. Create a subfolder for pre-processed images within the NIR folders for each flight.
4) Pre-process NIR imagery using MCC software.
a. Download MCC software from https://www.mapir.camera/products/mapircamera-control. The Survey3N NIR camera is a non-kernel camera, so click on the
“Download Windows Installer for MCC for All Non-Kernel Camera Customers”
download option. Open MCC software.
b. Open the MAPIR Camera Control *.exe file.
c. Select Survey3 from the Camera drop down menu
d. Select the Survey3N option from the Lens drop-sown menu
e. Select NIR from the Filter drop-down menu
f. Browse for the folder designated for the NIR images for the selected flight as the
“Input Folder”
g. Browse for the folder created for the pre-processed NIR images within the NIR
flight folder as the “Output Folder”
h. Select “Output Mono Band” > Band 1 (Red)
i. Click on the green “Process Images” button at the top of the window.
j. Repeat for the NIR images from each flight
5) Process imagery using WebODM. Note: WebODM is an open source software
available at github (https://github.com/OpenDroneMap/WebODM/). Installation
requires command line skills. Installation on a local area network, server operating
system, or multiuser computer does not work. It needs to be installed on a stand-alone
computer with a recommended 100 GB of free disk space and 16 GB RAM. Installers
are available for Windows and MacOS
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a.

Download and install WebODM

b. Open WebODM Manager and press Start WebODM.
c. When prompted, Open WebODM.
d. Create a new user account and login to the WebODM Dashboard
e. Click Add Project and enter a new project name and description, click Create
Project
f. Click on Select Images and GCP
g. Select and open the set of NIR or RGB images from the designated flight folder.
For best results, there should be 70 or more images to process for each NIR or
RGB image set from each flight.
h. Once images have uploaded, use the high-resolution default setting (RGB) and fast
orthophoto setting (NIR).
i. WebODM settings that produced the best results for RGB image sets were
“High-Resolution Settings” with ortho pixel resolution of 1 cm/pixel and
skip3D model selected under Options.
ii. WebODM settings that produced the best results for NIR image sets were
“Fast orthophoto” settings with ortho pixel resolution of 1 cm/pixel under
Options. However, try different settings under Options to achieve the best
results for each image set. If performing flights at a different height above
ground level, then use trial and error to find the best ortho pixel resolution
by examining orthophotos for distortions and clarity.
i. As the task is running, select Task Output On to monitor the line-by-line
processing. The processing time varies for each image set, but more images means
more processing time. RGB images can take from 12 – 24 hours with these
settings. NIR images take 1/2 – 2 hours with these settings.
j. When processing is complete, press the Download Assets button and download a
zip file of all assets. This will include the orthophoto as a geotiff file. Extract the
files.
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k. Open ArcMap and the Band 1 of the RGB image and Band 1 of the NIR image to
a new map document to prepare for the next steps.
i. With a new map document open in ArcMap, go to Windows > Catalog. In
the Catalog pane, navigate to the directory with the extracted RGB and
NIR orthophoto tiff files.
ii. Expand the files, by clicking on the plus sign to the left of the filename.
Click and drag Band 1 of each orthophoto onto the blank workspace.
iii. Save the map.
References
MAPIR Camera Control (MCC). MAPIR CAMERA.
https://www.mapir.camera/products/mapir-camera-control
WebODM. OpenDroneMap. https://www.opendronemap.org/webodm/
WebODM. Github. https://github.com/OpenDroneMap/WebODM/
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B.3 Radiometric Calibration of UAS Products
List of Instruments & Software:
1) OceanOptics Flame Spectrometer
a.

Spectrometer

b.

Fiber optic cable

c.

White reference standard

d.

USB cable

2) Calibration panels
3) Personal laptop computer
4) Thermal housing
a.

Cardboard box

b.

Styrofoam cooler

c.

Box tape

5) Thermometer with remote sensor probe (inexpensive digital thermometer for
monitoring reptile enclosure works)
6) OceanView Lite (free version downloadable at
https://oceanoptics.com/product/oceanview-downloads/)
7) Microsoft Excel
8) ESRI ArcMap
Procedure Summary:
1) Reflectance Data Acquisition
a. Set up calibration panels
b. Set up Spectrometer
c. Initiate software
d. Obtain groups of reflectance measurements for each calibration panel
e. Monitor temperature in thermal housing
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2) Reflectance Data Processing
a. Compile reflectance readings and prepare reflectance plots for each calibration
panel
b. Compile mean reflectance data for all calibration panels
3) Empirical Line Method
a. Extract mean DN values from RGB and NIR orthophotos for each calibration
panel
b. Plot reflectance against DN for each image and fit regression model
c. Apply calibration equations to orthomosaic in ArcMap
Detailed Procedure:
Note: Calibration panel reflectance remains the same for each flight unless the calibration
panels have been damaged or weathered, which may change the reflectance. Occasionally,
new reflectance data should be obtained for use in the empirical line method. If calibration
panels are in good condition, and the existing reflectance data is being used, then skip to
number 3, Empirical Line Method.
1) Reflectance Data Acquisition
a. Set up calibration panels
i.

The white, gray, and black calibration panels are taped to black duck cloth
using packing tape. This assembly was temporary for testing purposes. Fabric
glue should be considered for attaching the calibration panels to the backing
cloth for long-term use. The black duck cloth was used to reduce background
and adjacency effects while also anchoring the lightweight panels in place.

ii.

Lay the calibration panels flat on the ground, keeping them as horizontal as
possible. Calibration panels need to be flat for both reflectance acquisition and

b. Set up Spectrometer
i.

Unpack the OceanOptics spectrometer case, removing spectrometer, USB
cable, fiber optic cable, instructions, and white reflectance standard. The fiber
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optic cable is expensive and must be handled carefully. DO NOT bend or kink
the fiber optic cable.
ii.

Follow the brief instructions, “OceanOptics Spectrometer SOPs,” included in
the Spectrometer case to connect the spectrometer to a laptop, select correct
settings in the OceanView software, and save reflectance spectra.

iii.

Place the spectrometer in the thermal housing, making an indentation in the
corner of the Styrofoam and place the cables in the indentation. Gently close
the lid to the Styrofoam. Close the lid to the box allowing room for the cables
to exit the box and making sure not to bend or kink the fiber optic cable. The
sensor to the temperature probe should be placed in the thermal housing with
the display outside of the housing.

c. Obtain groups of reflectance measurements for each calibration panel
i.

Prior to obtaining the groups of reflectance readings for a calibration panel,
open the white reflectance standard and hold the fiber optic sensor just above
the white surface, at 45o to the horizontal, and press the yellow lightbulb to
update the white reference measurement.

ii.

For each measurement, hold the spectrometer 2” – 3” above the center of the
calibration panel at 45o to the horizontal. The calibration panels are 9.4”
square. To obtain the reflectance of the calibration panels with no mixed
pixels, or boundary effects, the spectrometer must be held only a few inches
from the center of the calibration panel surface. Look at the spectra on the
screen. It should be stable and not jumping around. If it looks good and the
spectra makes sense, then save the spectra.

iii.

Obtain between 5 and 10 readings for each calibration panel, taking readings at
the same height and angle to the horizontal, but rotating the fiber optic cable to
obtain measurements from many angles.

iv.

Repeat i – iii for each calibration panel.

d. Monitor temperature in thermal housing
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i.

Check the temperature in the thermal housing between groups of
measurements to ensure no temperature spikes occur. Take pictures of the
thermometer readout for easy tracking.

2) Reflectance Data Processing
a. Compile reflectance readings and prepare reflectance plots for each calibration
panel
i.

Open the directory where reflectance readings are saved. Individual reflectance
readings are saved as text files in Users > yourusername > oceanview. They
are date and time stamped to easily sort into groups of readings for each
calibration panel.

ii.

Create a new folder for each calibration panel and sort the text files into the
folders. With a fixed number of readings for each panel, it should be easy to
separate the files into groups.

iii.

Create a new Excel file for the first calibration panel

iv.

Open the text file in Excel for the first reading taken of the calibration panel. It
is a tab delimited file.

v.

Copy columns A and B starting on row 14, below >>>>>Begin Spectral
Data<<<<<. Column A is the wavelength data and column B is the reflectance
data. Past this data in the new sheet and add column labels for wavelength and
reflectance reading 1.

vi.

In Excel, open the text file for the next reading taken of the calibration panel.
Copy Column B starting on row 14 and paste the data in the next column of the
new spreadsheet with a column label for reflectance reading 2.

vii.

Continue to compile the data for each reading for the calibration panel until all
readings taken for the first calibration panel are in the same spreadsheet.

viii.

For the range of wavelengths from 380 nm to 900 nm (the range that includes
blue through NIR spectral response data), calculate the mean of the reflectance
readings obtained for the calibration panel for each 0.37 nm sampling interval.
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ix.

Create a plot of reflectance vs wavelength for all reflectance readings and the
mean of the reflectance readings for the calibration panel.

x.

Repeat these steps for each calibration panel.

b. Compile mean reflectance data for all calibration panels
i.

Copy the wavelength column and the mean reflectance from the first
calibration panel excel file and paste into a new empirical line method excel
file.

ii.

Copy the reflectance columns from the remaining calibration panel excel files
and paste into the new empirical line method excel file. Label the columns by
calibration panel.

3) Empirical Line Method
c. Average the reflectance values for the spectral range associated with the red band
in CMOS sensors (580 nm – 670 nm) for each calibration panel. Average the
reflectance at 850 nm for the NIR band for each calibration panel.
d. Extract mean DN values for each calibration panel
i.

Open the map document containing Band 1 of the RGB and Band 1 of the NIR
orthophotos created in ArcMap in the “UAS Image Acquisition and
Processing” procedures.

ii.

In ArcMap, open the Catalog pane. Right click on the working directory and
select New > Shapefile. Create a polygon shapefile with
WGS_1984_UTM_Zone_10N coordinate system.

iii.

Zoom in on the calibration panels in the orthomosaics. Go to Windows >
Toolbars > Editor. In the dropdown on the Editor toolbar, click on Start
Editing. Select the shapefile you just created and click OK. In the Create
Features pane, select the shapefile and click on polygon or rectangle under
Construction Tools. Draw rectangular polygons over each calibration panel in
the Red Band (Band 1 of RGB). To extract a similar number of pixels for each
calibration panel, copy and paste the first polygon. Create a new shapefile and
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draw rectangular polygons over each calibration panel in the NIR Band.
Enclose the center of the calibration panels, where the pixels are pure and not
influenced by boundary effects. There should be two sets of polygons, one for
Red and one for NIR. New Polygons do not need to be created, but previous
polygons can be reused. In the Catalog pane, navigate to the folder containing
polygons used to extract spatial data previously (named
RGB_calibrationzones_date.shp and NIR_calibrationzones_date.shp). If using
previous polygons, just drag and drop from the Catalog pane onto the map.
iv.

Open Customize > Extensions and check that the Spatial Analyst extension is
selected.

v.

Open ArcToolbox and navigate to Spatial Analyst Tools > Zonal > Zonal
Statistics as Table.

vi.

Under “Input raster or feature zone data,” select the shapefile created for the
Red Band. Under “Zone field,” select FID and Under “Input value raster,”
select the Red Band raster. Click OK. Repeat for NIR.

vii.

Right-click on the table titles in the Table of Contents pane and open the
tables. These are the statistics for the digital numbers (DNs) for each band.
Copy the Mean DN for each calibration panel and paste into the empirical line
method excel worksheet. The order of the entries in the table correspond to the
order the polygons were created.

e. Plot reflectance against DN for each image and fit regression model
i.

In the empirical line method worksheet, the averaged reflectance in the red
band (580 nm – 670 nm) for each calibration panel should be placed in one
column and the extracted mean DN value extracted from the red band
orthophoto should be placed in the column to the right.

ii.

Plot the Mean reflectance vs the mean DN for the red band, creating a scatter
plot of 3 data points, one for each calibration panel.
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iii.

Add a linear trend line to the scatter plot and display the equation and R2 value.
This equation is the calibration equation.

iv.

Repeat for the NIR data.

f. Apply calibration equations to orthomosaic in ArcMap
i.

Open the ArcMap map document with the orthomosaics.

ii.

Open ArcToolbox and navigate to Spatial Analyst Tools > Map Algebra >
Raster Calculator.

iii.

Enter the calibration equation in the form:
𝑎 ∗ 𝐷𝑁 − 𝑏
Where a and b are obtained from the calibration equation and DN is the Red or
NIR orthophoto selected from the list of files on the left of the raster calculator
pane. Select the save location and name of the resulting raster. Perform this
step for both orthophotos using the corresponding calibration equation.

iv.

The resulting rasters will likely now contain negative DN values for some
pixels. To set these values to zero, open the Raster Calculator again and use a
conditional statement to trim the negative DN values from each calibrated
orthophoto.
Con ((“OrthophotoBand” >=0), “OrthophotoBand”)

References
OceanOptics Flame Spectrometer Operating Manual. OceanOptics, Inc.
https://oceanoptics.com/product/flame-spectrometer/#tab-downloads
OceanView Lite. OceanOptics, Inc. https://oceanoptics.com/product/oceanview-downloads/
OceanOptics Spectrometer SOPs.
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B.4 NDVI Generation
List of Instruments & Software:
1) ESRI ArcMap
2) Microsoft Excel
Procedure Summary:
1) Add control point data
2) Georeference two calibrated orthophotos
3) Create NDVI maps
4) Extract and plot spatial data
5) Extract and plot AOI data for fIPAR-NDVI regression
6) Extract and plot temporal data
Detailed Procedure:
1) Add 2014 control point data
a. Open ArcMap and navigate to the map with the calibrated NIR and RGB
orthophotos. The four corners of the rain garden structure were surveyed in 2014.
Go to File > Add XY Data and navigate to the control point data
(OGSIR_4corners.csv). Under X Field, select Easting. Under Y Field, select
Northing. Set the coordinate system to NAD 1983 StatePlane Oregon FIPS (Intl
Feet) and click OK.
b. At this point, everything should seem misaligned. We need to transform the
control point coordinates into the same coordinate system as the orthophotos. Go
to ArcToolbox > Data Management Tools > Projections and Transformations >
Project. Under Input Dataset dropdown, select the control point data you just
added. Under output dataset, select a save location and name the output file. Click
on the button next to Output Coordinate System and select
WGS_1984_UTM_Zone_10N (this can be searched for by name). Click OK.
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2) Georeference the two orthophotos to the control points.
a. Go to the Customize menu > Toolbars > Georeferencing. On the Georeferencing
toolbar dropdown, select the RGB Red band orthophoto.
b. Zoom in to one corner of the rain garden so that the control point and the corner
wall as displayed in the imagery are visible.
c.

Click on the Add Control Points button on the Georeferencing toolbar. Click first
on the rain garden corner in the imagery and then click on the control point.

d. Continue for the other three corners.
e. Once the image has shifted to closely match the control points, click on View Link
Table on the Georeferencing toolbar. This shows the residual for each control
point. These values should all be small, less than 0.05.
f. Go to the Georeferencing toolbar dropdown and select Update Georeferencing.
g. Repeat for the NIR orthophoto.
3) Create NDVI map
a. Go to ArcToolbox > Data Management Tools > Raster > Raster Processing >
Composite Bands. Select the NIR raster from the dropdown for Input Rasters.
Then, select the RGB Red band raster from the dropdown for Input Rasters. Select
save location and name the output raster. Click on OK. The composite bands tool
places the first raster on the list of input rasters as Band 1 of the new composite
bands raster.
b. In ArcMap, Go to Windows > Image Analysis. Click on the Options button in the
top left corner of the Image Analysis pane. If the first raster on the Composite
Bands list was the NIR raster, then set the Red Band to 2 and the NIR band to 1 in
the Image Analysis Options pane. Select Scientific Output and click on OK.
c. In the Table of Contents pane, look for the new layer containing the NDVI map.
Click on the plus sign to the left of the layer and make sure the range on the color
ramp is within -1 and 1.
d. Repeat step b. to create a second NDVI map.
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e. Right click on the second NDVI map layer in the Table of Contents pane and
select Layer Properties. Go to Symbology and select Classified. Select an
appropriate color ramp (red through yellow to green is a good illustration of
NDVI). Under Classification, select Classify to open the Classification window.
Select the Equal Interval Method and click OK. Select 10 classes. Using 10 classes
shows more detail in the resulting map than fewer classes. Click OK to close the
Layer Properties window.
f. With one of the NDVI layers active and visible, go to the Layout View. Go to
Insert > Legend and Insert > North Arrow. Adjust positioning in Layout View and
go to File > Export Map. Repeat with the other NDVI layer active and visible to
save the floating point NDVI map and the classified NDVI map.
4) Extract Spatial Data
a. In ArcMap, go to Windows > Catalog and create a new shapefile (polygon) with
the WGS_1984_UTM_Zone_10N coordinate system. Select Start Editing in the
Editor toolbar and select the new shapefile. In the Create Features pane, select the
shapefile and the Polygon Construction Tool.
b. Draw polygons covering vegetation in each cell and dividing the cell into 19
segments moving away from the inlet. Each polygon should be approximately 1.5
m long and the width of the Cell (3.2 m). When vegetation overlaps the edges of
the cell, draw a custom polygon shape enclosing the vegetation into the polygon.
New Polygons do not need to be created, but previous polygons can be reused.
In the Catalog pane, navigate to the folder containing polygons used to extract
spatial data previously (named Cell#_Slice#_date.shp). If using previous polygons,
just drag and drop from the Catalog pane onto the map.
c. Go to ArcToolbox. navigate to Spatial Analyst Tools > Zonal > Zonal Statistics as
Table.
d. Under “Input raster or feature zone data,” select the shapefile created for slice of
the bioretention cell. Under “Zone field,” select FID and Under “Input value
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raster,” select the NDVI floating point raster. Click OK. Repeat for each polygon
labeling the statistics tables appropriately.
e. Right-click on the table titles in the Table of Contents pane and open the tables.
These are the statistics for the NDVI values for each band. Copy the Mean NDVI
value for each slice of each bioretention cell and paste into an Excel worksheet.
f. In Excel, plot the Mean NDVI against the distance from the inlet (measured from
the S end of each bioretention cell to the center of the polygon slice) for each
bioretention cell.
5) Extract and plot AOI NDVI data for fIPAR – NDVI regression analysis
a. Open the ArcMap file with NDVI data. Add XY Data to add fIPAR data, with X =
Easting, Y = Northing, Z = fIPAR.
b. Project fIPAR coordinate system to WGS_1984_UTM_Zone_10N.
c. Create a new shape file, a circular polygon for an AOI with a diameter of 32
inches, centered at one fIPAR point. Copy the polygon and paste it centered at
each fIPAR point.
d. Using Zonal Statistics as Table, extract the mean NDVI value from the floating
point NDVI layer.
e. Save the Mean NDVI values in an Excel worksheet. Copy the mean fIPAR values
for each corresponding point into a column next to the NDVI values. Plot fIPAR
vs NDVI and fit a linear trend line, showing the equation and R2 value.
6) Extract NDVI data for Temporal Analysis and plot several dates worth of data.
a. Open ArcToolbox and navigate to Spatial Analyst Tools > Map Algebra > Raster
Calculator.
b. Enter a conditional expression to extract a class of NDVI data and save in a new
appropriately labeled raster.
Con(("NDVI_raster" <= 1) & ("NDVI_raster" >= 0.6),"NDVI_raster")
For temporal analysis, four classes of NDVI data need to be extracted:
“Healthy”: 0.6 – 1.0
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“Stressed”: 0.2 – 0.6
“Soil and Dying or Dead Vegetation”: -0.2 – 0.2
“No Vegetation”: -1.0 – -0.2
Repeat the conditional statement in Raster Calculator for the remaining three
classes of data.
c. Create a polygon covering all vegetation in cell 1. Repeat for cells 2 and 3.
d. Using Zonal Statistics as Table, extract all statistics from each of the new NDVI
class rasters.
e. Open the statistics tables and copy the Area for each NDVI class and paste into an
Excel worksheet.
f. Repeat for additional NDVI data from other dates.
g. Plot Area vs Time for each NDVI class showing four series of data (4 classes) on
one plot to track changes in the Area covered by each NDVI class over time.

